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Copyright and Disclaimer
Product specifications are subject to change without notice and do not represent a commitment on the part of 
Avid Technology, Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 4,746,994; 4,970,663; 
5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 
5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 
5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,987,501; 6,061,758; 6,223,211; 6,301,105; 6,532,043; 
6,546,190; 6,636,869; 6,747,705, 6,763,523; 6,813,622. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid Interplay Transfer may reproduce this 
publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or 
distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or 
educational services to others. This document is supplied as a guide for Avid Interplay Transfer. Reasonable care has been 
taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or 
typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of 
this document. Product specifications are subject to change without notice.

Copyright © 2006 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
Portions of this software are based on work of the Independent JPEG Group.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

http://www.avid.com
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The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:

The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, 
Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid DS Assist Station, Avid ISIS, 
Avid Learning Excellerator, Avid Liquid, Avid Mojo, AvidNet, AvidNetwork, Avid Remote Response, AVIDstripe, Avid Unity, 
Avid Unity ISIS, Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, DAE, Dazzle, Deko, DekoCast, D-Fi, 
D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, 
Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, D-Verb, Equinox, ExpertRender, Face Robot, 
FieldPak, Film Composer, FilmScribe, FluidMotion, HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, 
Image Independence, iNEWS, iNEWS ControlAir, Instinct, Interplay, Intraframe, iS9, iS18, iS23, iS36, LaunchPad, Lightning, 
Lo-Fi, Magic Mask, make manage move | media, Marquee, Matador, Maxim, MCXpress, Media Browse, Media Composer, 
MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, Media Reader, Media Recorder, MEDIArray, 
MediaShare, MediaStream, Meridien, MetaSync, MissionControl, NaturalMatch, Nearchive, NetReview, NewsCutter, Nitris, 
OMF, OMF Interchange, OMM, Open Media Framework, Open Media Management, PCTV, Pinnacle MediaSuite, 
Pinnacle Studio, Pinnacle Systems, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, ScriptSync, 
SecureProductionEnvironment, Show Center, Softimage, Sound Designer II, SPACE, SPACEShift, SpectraGraph, 
SpectraMatte, SteadyGlide, Symphony, TARGA, Thunder, Trilligent, UnityRAID, Vari-Fi, Video RAID, Video Slave Driver, 
VideoSPACE, and Xdeck are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or 
other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners.

GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — Broadcasters — Content 
creators of every genre — Just finished an incredible project and want to share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid Interplay Transfer Setup and User’s Guide • 0130-07634-01 Rev A • June 2006 • 06/13/06 13:54
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Using This Guide

Congratulations on your purchase of an Avid® Interplay™ Transfer application. You can use 
your application to move Avid assets (media and metadata) and manage the transfer of assets 
to and from workgroups in an Avid Unity™ environment. You can also use Avid Interplay 
Transfer in a standalone environment to move assets between workstations. The Interplay 
Transfer system transfers assets to and from supported third-party applications, devices, and 
archive integration systems.

This guide contains all the task-oriented instructions, conceptual information, and reference 
material you need to transfer assets in an Avid Unity or in a standalone environment.

This guide is intended for all Avid Interplay Transfer users, from beginning to advanced.

n The documentation describes the features and hardware of all models. Therefore, your 
system might not contain certain features and hardware that are covered in 
the documentation.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

If You Need Help

If you are having trouble using Avid Interplay Transfer software:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check for the latest information that might have become available after the 
documentation was published:

- If the latest information for your Avid product is provided as printed release notes, 
they ship with your application and are also available online.

- If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied on your Avid installation CD-ROM or DVD as a PDF document and is 
also available online.

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

t This symbol indicates a single-step procedure. Multiple arrows in a 
list indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Ctrl+drag.
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You should always check online for the most up-to-date ReadMe because the online 
version is updated whenever new information becomes available. To view these 
online versions, select ReadMe from the Help menu or visit the Knowledge Base at 
www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, 
and to read/join online message-board discussions.

How to Order Documentation

To order additional copies of this documentation from within the United States, call Avid 
Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the United 
States, contact your local Avid representative.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery 
methods that accommodate your pressured and competitive work environment.

To learn about Avid's new online learning environment, Avid Learning Excellerator™ 
(ALEX), visit http://learn.avid.com.

For information on courses/schedules, training centers, certifications, courseware, and 
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID 
(800-949-2843).

http://www.avid.com/onlinesupport
http://learn.avid.com
http://www.avid.com/training
http://www.avid.com/readme 
http://www.avid.com/readme 
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Chapter 1

Avid Interplay Transfer Overview

Avid Interplay Transfer lets you transfer Avid assets to and from another workgroup, send 
finished sequences to a configured playback device, and capture media from a configured 
ingest device. You can also use Interplay Transfer in a standalone environment (an 
environment other than Avid Unity) to move Avid assets between workstations.

Interplay Transfer receives and queues transfer requests from one or more clients. Transfers 
are then initiated by the Interplay Transfer server to off load the client. 

You can monitor the status of all transfers using the Interplay Transfer Status view from 
within the Avid Interplay Access or you can monitor your own transfers from within your 
Avid editing application. A standalone system can also monitor the status of transfers using 
the Avid Interplay Media Services and Transfer Status software. You can designate a single 
cache engine to monitor the transfers handled by several Interplay Transfer systems, 
AirSpeeds, or other Interplay Transfer enabled devices.

The following topics in this chapter provide an overview of working with Interplay Transfer:

• Understanding Interplay Transfer Configurations

• Networking Considerations

• Transfer Types

• Support for MXF/AAF Media

Read through this chapter to become familiar with the various types of transfers available 
with Interplay Transfer. For installation and configuration information, see “Avid Interplay 
Transfer Installation” on page 19 and “Interplay Transfer Configuration” on page 37. When 
you are ready to transfer assets, follow the procedures in “Transferring Avid Assets” on 
page 75 and “Transferring Avid Assets in a Standalone Environment” on page 80.
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Understanding Interplay Transfer Configurations

Interplay Transfer can be configured in Avid Unity environments or in a standalone 
configuration (without Avid Unity MediaNetwork, Avid Unity LANshare, or Avid 
Unity ISIS™).

n For optimal capture performance, configure one ingest or playback device per Interplay 
Transfer server.

A workgroup enables collaborative workflows by allowing multiple editors to share media. 
For diagrams showing typical shared-storage workgroup configurations, see the Avid 
Interplay Best Practices document.

Your workgroup environment might consists of the following components, depending on the 
workgroup configuration:

• Avid Unity MediaNetwork or Avid Unity ISIS media network file server and storage

• Fibre Channel network that connects the Avid editing systems, Avid Interplay Server, 
and Interplay Transfer server to the Avid Unity MediaNetwork environment

• Ethernet network that connects the Avid editing systems, Avid Interplay Server, and 
Interplay Transfer server to the Avid Unity ISIS media network environment

• Avid Interplay Engine to track and manage Avid Unity or Avid Unity ISIS media

• Supported Avid editing applications, such as Media Composer® or NewsCutter®

• Interplay Transfer server to manage the transfer of media to and from the workgroup, 
and to and from other workgroups

• Ethernet network used as a general-purpose communication network

Supported Avid Interplay Transfer Configurations

The supported Interplay Transfer configurations are:

• A dedicated Interplay Transfer server connected to an Avid Unity MediaNetwork, Avid 
Unity LANshare, or Avid Unity ISIS that includes an Avid Interplay Server.

• Standalone Interplay Transfer software installed on an Avid editing system (Microsoft® 
Windows® XP operating system only) that is connected to an Avid Unity LANshare 
without an Avid Interplay Engine (not Avid Unity MediaNetwork or Avid Unity ISIS). 
Each networked client must install both the Interplay Transfer Engine software and the 
Interplay Transfer client software.

n Standalone Interplay Transfer is not supported on Avid Instinct™ systems.

• Standalone Interplay Transfer software installed on an Avid editing system (Microsoft 
Windows XP operating system only) with local storage.
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Networking Considerations

For two workgroups to cooperate, some workstations in one workgroup have to be able to 
access services in the other workgroup. If these workgroups are not in the same site, or are 
separated by routers or firewalls, you have to establish access to allow these services 
to work.

The main components are an Avid Interplay Engine and two Interplay Transfer Engines. All 
these services are TCP/IP based. 

• The Avid Interplay Engine leverages the standard HTTP service on port 80. 

• The two Interplay Transfer Engines use port numbers that are defined in the services file 
in \WINDOWS\SYSTEM32\DRIVERS\ETC\.

As installed, these port numbers are 6539 and 6532, respectively.

Remote Workgroup Connectivity Rules

For minimal remote workgroup connectivity, the following rules apply:

• Avid editing clients must be able to access the remote Interplay Transfer server and Avid 
Interplay Engine services.

• Interplay Transfer servers must be able to access the remote Media Transfer service. 
Interplay Transfer servers access only workgroup-local Avid Interplay Engine services, 
not remote ones.

• Avid Interplay servers must be able to access the remote Interplay Transfer service.



 Chapter 1 Avid Interplay Transfer Overview

16

Typical Configuration

The following figure shows a typical configuration.

EditingClient_A_1

MediaManager_A

TransferManager_A

Workgroup A

EditingClient_B_1

MediaManager_B

TransferManager_B

Workgroup B

LAN
LAN

Router/Firewall Router/Firewall

Avid Interplay Server_BAvid Interplay Server_A

Avid Interplay Transfer Server_A Avid Interplay Transfer Server_B
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Remote Workgroup Network Configuration

The figure in “Typical Configuration” on page 16 shows only one Avid editing client per 
workgroup. You should assume that there are more clients and that each client requires the 
same connectivity. To access Interplay Transfer when network traffic is restricted at the 
router/firewall point, the network administrator must enable the combinations listed in the 
following table.

Use the following table to verify which port numbers to use depending on your source and 
destination.

Any additional Avid editing clients should follow the rules listed in “Remote Workgroup 
Connectivity Rules” on page 15.

Remote Workgroup Network Connection Guidelines  

Source Destination Port

EditingClient_A_1 Avid Interplay Server_B http:80

EditingClient_A_1 Avid Interplay Transfer Server_B 6539

EditingClient_B_1 Avid Interplay Server _A http:80

EditingClient_B_1 Avid Interplay Transfer Server _A 6539

Avid Interplay Server _A Avid Interplay Transfer Server _B 6539

Avid Interplay Server _B Avid Interplay Transfer Server _A 6539

Avid Interplay Transfer Server_A Avid Interplay Transfer Server _B 6532

Avid Interplay Transfer Server _B Avid Interplay Transfer Server _A 6532
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Transfer Types

When you use Interplay Transfer in a workgroup environment, there are several types of 
transfers available.

• You can perform a transfer from within the Avid editing system (for example, 
NewsCutter) to another workgroup or playback device. See “Transferring Avid Assets 
from Within an Avid Editing Application to Another Workgroup” on page 76.

• You can perform a remote transfer from the Avid Interplay Access user interface. See 
“Transferring Avid Assets from Workgroup to Workgroup” on page 77.

• You can “pull” media from a remote Avid Interplay Engine directly to your Avid editing 
system’s bin. See “Transferring Avid Assets from a Remote Workgroup to Your Avid 
Editing System” on page 77. 

• You can capture media from a configured ingest device to your Avid editing system’s 
bin. See “Transferring Files from an Ingest Device” on page 84.

• If you are working in an Avid Unity for News workgroup, you can transfer finished 
sequences to a configured playback device. See “Transferring Avid Assets to a Playback 
Device” on page 81.

• You can import and export MXF OP1a files into an Avid Unity, Avid ISIS, or an Avid 
editing environment from an FTP server. See “Transferring To and From Generic FTP 
Servers” on page 85

• You can capture media from FTP video servers. See “Capturing From FTP Deck 
Devices” on page 89.

• You can drag and drop from Workgroup 4.5 to an Avid Interplay workgroup if you are 
going from the MediaManager browser to a standalone Avid Interplay Access or to an 
Interplay Window. See “Transferring Avid Assets from Workgroup 4.5 to an Interplay 
Workgroup” on page 79.

Support for MXF/AAF Media

MXF media created and edited in an Avid editing application can be shared in an Avid 
Interplay environment with other Avid MXF-capable devices. For a description of 
compatible issue between the various Avid products when working in an Avid Interplay 
workgroup, see the Avid Interplay Best Practices document.

c Any third-party video servers included in an Interplay Transfer workgroup must 
support integration with an Avid MXF workgroup. Check with the manufacturers of 
the third-party video servers to verify that your video servers support Avid 
MXF workgroups. 



Chapter 2

Avid Interplay Transfer Installation

This chapter describes how to add an Avid Interplay Transfer server to an Avid Interplay 
workgroup. The Interplay Transfer server is an Avid Unity client in the Avid Unity 
environment. This chapter also describes how to install the Interplay Transfer Engine in a 
workgroup environment and a standalone configuration. Other procedures describe where 
and how to install the Interplay Transfer support software.

The following sections are included in this chapter:

• Installation and Configuration Check List

• Installing Cards in the Interplay Transfer Server

• Turning On the Interplay Transfer Server

• Installing Avid Unity Client Software

• Connecting the Application Key

• Understanding the Software Required for Performing Transfers

• Installing the Interplay Transfer Engine in a Workgroup Environment

• Installing Interplay Transfer Support Software

• Installing the Interplay Transfer Software in a Standalone Environment
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Installation and Configuration Check List

The following sections provide check lists for setting up an Interplay Transfer server and 
installing the Interplay Transfer support software.

• Check List for Installing and Configuring an Interplay Transfer Server

• Check List for Installing and Configuring Interplay Transfer in a Standalone 
Environment

• Check List for Installing Interplay Transfer Support Software

Check List for Installing and Configuring an Interplay Transfer Server

The following table provides a check list of steps for installing and configuring the Interplay 
Transfer server in an Avid Unity workgroup and includes pointers to information about each 
step. The check list also covers installing and configuring the Interplay Transfer client 
software on an Avid editing system.

Interplay Transfer Installation and Configuration Check List  

Task Section Reference

! Check your configuration. See “Supported Avid Interplay Transfer 
Configurations” on page 14.

! Review network considerations. See “Networking Considerations” on page 15.

! Connect the Interplay Transfer server hardware 
and cables.

In a workgroup, the Interplay Transfer server is an 
Avid Unity client. Depending on your Avid Unity 
environment, see the following documents:

For Avid Unity ISIS, see the Avid Unity ISIS 
client setup documentation.

For Avid Unity MediaNetwork, see the 
Avid Unity MediaNetwork client setup 
documentation.

! Install cards in the Interplay Transfer server. See “Installing Cards in the Interplay Transfer 
Server” on page 24.

! Make sure Avid Unity File Manager software 
is installed on the File Manager server and is 
running.

See the Avid Unity File Manager documentation.
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! Start the Interplay Transfer server. See “Turning On the Interplay Transfer Server” 
on page 25.

! Install the Avid Unity ISIS or Avid Unity 
MediaNetwork client software.

See “Installing Avid Unity Client Software” on 
page 26.

! Make sure the Avid Unity server has a user 
account for the Interplay Transfer server and 
any AirSpeed® devices.

See the Avid Unity documentation.

! Connect the Interplay Transfer application key. See “Connecting the Application Key” on 
page 26.

! Install the Avid Interplay Framework for Server 
software. 

See the Avid Interplay Software Installation 
Guide. 

! Install the Avid Interplay Access software. See the Avid Interplay Engine and Avid Interplay 
Access Installation Guide.

! Install the Interplay Transfer Engine. See “Installing the Interplay Transfer Engine 
Software” on page 29.

! Setup the Avid Interplay Transfer Engine 
Configuration tool.

See “Understanding the Avid Interplay Transfer 
Engine Configuration Settings” on page 38.

! Register the Interplay Transfer Engine in the 
workgroup.

See “Configuring an Avid Interplay Workgroup 
For Transfers” on page 46.

Avid Editing System

! Install the Interplay Transfer client software on 
Avid editing systems.

See “Installing the Interplay Transfer Client 
Software” on page 31.

! Configure the Transfer settings in the Avid 
editing application.

See “Configuring the Avid Editing Application 
for Transfers” on page 57.

Interplay Transfer Installation and Configuration Check List (Continued)  

Task Section Reference
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Check List for Installing and Configuring Interplay Transfer in a 
Standalone Environment

The following table provides a check list of steps for installing and configuring the Interplay 
Transfer software in a standalone environment and references where to find more 
information about each step.

Standalone Interplay Transfer Installation and Configuration Check List  

Task Section Reference

! Check your configuration. See “Supported Avid Interplay Transfer 
Configurations” on page 14.

! Connect the Interplay Transfer 
application key.

See “Connecting the Application Key” on page 26.

! Install the Interplay Transfer Engine 
software on Avid editing systems.

See “Installing the Interplay Transfer Software in a 
Standalone Environment” on page 33.

! Install the Interplay Transfer client 
software on Avid editing systems.

See “Installing the Interplay Transfer Client 
Software in a Standalone Environment” on page 35.

! Setup the Interplay Transfer Engine 
Configuration tool.

See “Understanding the Avid Interplay Transfer 
Engine Configuration Settings” on page 38.

! Configure the Transfer settings in the 
Avid editing application.

See “Configuring the Avid Editing Application for 
Transfers” on page 57.
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Check List for Installing Interplay Transfer Support Software

Depending on your workgroup configuration and the type of transfers performed in your 
workflow, you might need to install additional support software to transfer Avid assets or 
monitor transfers. The following table lists the support software and references where to find 
more information about installing the software.

Interplay Transfer Support Software Installation Check List  

Task Section Reference

! Install the Avid Interplay Adapter 
software (Avid Interplay Adapter 
service).

See “Installing the Avid Interplay Adapter Service” 
on page 32.

! Install the Avid Interplay Media 
Services and Transfer Status software.

See “Installing the Interplay Media Services and 
Transfer Status Tool” on page 33.
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Installing Cards in the Interplay Transfer Server

The cards included with the Interplay Transfer server depend on the Avid Unity environment 
where the Interplay Transfer server is being installed.

• In an Avid Unity ISIS environment, the Interplay Transfer server might ship with an 
Intel® PRO/1000 Server Adapter gigabit card, depending on your system’s 
configuration. This card must be installed in slot 3 (top slot). Follow the directions 
supplied with the card. For information on configuring the Intel PRO/1000 card, see 
“Configuring the Intel PRO/1000 Adapter Card” on page 24. 

• In an Avid Unity MediaNetwork environment, the Interplay Transfer server might ship 
with an Intel PRO/1000 Server Adapter gigabit card and an ATTO™ Fibre Channel card, 
depending on your system’s configuration. These cards must be installed in the 
appropriate slots:

- Install the Intel PRO/1000 Server Adapter card in slot 2 (the middle slot) of the 
Interplay Transfer server. Follow the directions supplied with the card. For 
information on installing the Intel PRO/1000 driver, see “Configuring the Intel 
PRO/1000 Adapter Card” on page 24. 

- Install the ATTO Fibre Channel card in slot 3 (the top slot) of the Interplay Transfer 
server. Follow the directions supplied with the card.

Configuring the Intel PRO/1000 Adapter Card

The Intel PRO/Adapter card might require the installation of the Intel Pro/1000 driver. After 
you install the driver, you need to configure the card. This section provides procedures for 
installing the driver and configuring the card.

Installing the Intel PRO/1000 Driver

After you install the Intel PRO/1000 Server Adapter card and restart your system, a message 
might appear, looking for the Intel PRO/1000 driver. 

To install the Intel PRO/1000 driver:

1. Open the C:\IntelPro folder.

2. Click the Autorun.exe file.

The Intel Pro Network Connections window opens.

3. Click Install Drivers.

4. Click Finish.
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Configuring the Intel PRO/1000 for Jumbo Frames

After you install the Intel PRO/1000 server adapter card and update the driver, you must 
configure the card to work correctly with the Interplay Transfer server.

To configure the Intel PRO/1000 card:

1. Right-click the My Network Places icon, and select Properties.

2. Right-click the file for the Intel Pro interface used by Interplay Transfer and select 
Properties.

3. Click Configure.

4. Click the Advanced tab.

5. In the Property area, select Jumbo Frames.

6. In the Value area, select 9014Bytes.

7. Click OK.

Turning On the Interplay Transfer Server

Before you can turn on the Interplay Transfer server, you need to do the following:

• Connect the Interplay Transfer server hardware and cables. See the Avid Unity client 
setup documentation.

• Make sure the Avid Unity File Manager software installed on the Avid Unity File 
Manager server is running.

To start your Interplay Transfer server:

1. Turn on all the peripherals connected to the Interplay Transfer server. 

Make sure their power lights are on.

2. Press the Power button on the Interplay Transfer server. 

The MEDIASwitch port lights turn on as the Interplay Transfer server becomes ready.
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Installing Avid Unity Client Software

After the Interplay Transfer server starts properly, and before you install the Interplay 
Transfer Engine, you must install the Avid Unity client software. 

In an Avid Unity environment, the Interplay Transfer server is a client.

• In an Avid Unity ISIS environment, the Interplay Transfer server is an Avid Unity ISIS 
client. To install the Avid Unity ISIS client software, see the Avid Unity ISIS Client 
Quick Start Card.

• In an Avid Unity MediaNetwork environment, the Interplay Transfer server is a 
MediaNetwork client. To install the Avid Unity MediaNetwork client software, see the 
Avid Unity MediaNetwork Windows Fibre Channel Client Setup Guide.

Connecting the Application Key

Before you install the Interplay Transfer Engine, you need to connect the Interplay Transfer 
USB application key (also called a dongle). The application key lets the Interplay Transfer 
application run on your system. The computer sees the application key when it is booting.

To connect the application key, do one of the following:

t On the Interplay Transfer server system, connect the application key to a USB port.

t In a standalone configuration, connect the key to the Avid editing system.

c Do not lose the USB application key. Your Interplay Transfer software does not 
function without it. If you lose your application key, you must purchase another key 
from Avid at the full market cost of your software.

 Application key (dongle)
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Understanding the Software Required for 
Performing Transfers

To perform transfers you need to install specific software components on the various servers 
and systems. Which software you install and where you install it, depends on your 
workgroup environment. The following table outlines where the software components are 
installed to perform transfers. You should use this table as a guide, depending on your 
workgroup environment.

The following sections provide procedures for installing the software components on the 
Interplay Transfer server and Avid editing system. For detailed steps on installing Avid 
Interplay Engine and Avid Interplay Framework for Client, see the Avid Interplay Software 
Installation Guide.

Software Installation Location  

Software

Installed on 
Avid Interplay 
Server

Installed on 
Interplay Transfer 
Server

Installed on 
Avid Editing 
Client

Interplay Transfer Engine " "a

a.  Install only if in a standalone environment (not an Avid Unity environment).

Interplay Transfer Client "

Avid Interplay Engine "

Avid Interplay Adapter (option) "

Avid Interplay Access " "b

b.  Not required. However, this software provides easy access to the Avid Interplay Administrator.

"

Interplay Framework for Server  " "

Avid Unity ISIS Client or 
Avid Unity MediaNetwork Clientc 

c.  The media network client software you install depends on your Avid Unity environment.

" " "
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After your hardware is properly set up, perform the following software installation 
procedures on the Interplay Transfer server:

• Install the Interplay Framework for Server software. See the Avid Interplay Software 
Installation Guide.

• Install the Avid Interplay Access software. See the Avid Interplay Software Installation 
Guide. 

• Install the Interplay Transfer Engine software. See “Installing the Interplay Transfer 
Engine Software” on page 29.

Install the following software on the various systems:

• Install the Interplay Transfer Client software on the Avid editing systems. See 
“Installing the Interplay Transfer Client Software” on page 31.

• (Option) Install the Avid Interplay Media Services and Transfer Status application on a 
standalone system. See “Installing the Interplay Media Services and Transfer Status 
Tool” on page 33.

• (Option) Install the Avid Interplay Adapter software on the Avid Interplay Server. See 
“Installing the Avid Interplay Adapter Service” on page 32.

Installing the Interplay Transfer Engine in a 
Workgroup Environment

After you install the Avid Unity client software on your Interplay Transfer server, you can 
install the Interplay Transfer Engine software. Then you need to install the Interplay 
Transfer client software on each client in the workgroup. The following sections provide 
procedures for installing the Interplay Transfer software.

c You are reminded that data networks, such as standard data networks that support 
Internet Protocols, are not necessarily secure networks, and that any transfer of 
information over such networks — whether internally or externally — is not 
necessarily a secure transfer. As when you communicate any information over any 
network, you are responsible for ensuring that you use network settings or implement 
policies that meet your security needs. Like other applications designed for use over a 
data network, the Interplay Transfer application provides the capability for making 
transfers over a network but does not provide security for such transfers over 
unsecured networks. Avid makes no representations that transfers using Interplay 
Transfer will be secure. Avid recommends that, before using Interplay Transfer to 
transfer Avid assets over a network, you first evaluate your own security needs and 
implement appropriate measures to accommodate those needs, such as building any 
requisite firewalls and obtaining security certificates, or any other measures that you 
deem necessary to protect media being transferred over any network.
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n While Avid systems include password protection, such passwords are provided solely for 
your convenience to protect access to the Avid systems themselves and do not affect the 
security of information transferred over an unsecured data network.

Installing the Interplay Transfer Engine Software 

In a workgroup environment you need to install the Interplay Transfer Engine on the 
Interplay Transfer server system. This software also installs the Avid Interplay Transfer 
Engine Configuration software, which lets you set up the particular configuration for your 
Interplay Transfer server. For descriptions of the Avid Interplay Transfer Engine 
Configuration options, see “Understanding the Avid Interplay Transfer Engine 
Configuration Settings” on page 38.

To install the Interplay Transfer Engine software:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file.

2. Click Servers on the Main Menu page, and then click Avid Interplay Transfer Engine.

The Install Avid Interplay Transfer Engine page opens.

3. Make sure the following components are installed on the Interplay Transfer server:

- Avid Interplay Framework for Server

- Avid Interplay Access

For installation procedures, see the Avid Interplay Software Installation Guide.

4. Click Avid Interplay Transfer Server.

5. In the Welcome window, click Next.
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6. Click the applicable country, and click Next.

7. Click Yes to accept the license agreement.

8. In the “Choose the installation type that best suits your needs” dialog box, select one of 
the following:

- Avid Interplay Transfer Engine with Supplemented FTP Services – if your 
workgroup configuration includes supported ingest or playback FTP devices, such 
as Sony® e-VTR or Thunder® production server. 

c Do not install FTP services on a server used with Avid AirSPACE™.

- Avid Interplay Transfer Engine – to install the standard Avid Interplay Transfer 
Engine.

9. Click Next.

10. Click Next to accept the location for the application.

11. The installer verifies that Microsoft NET Framework 1.1 is installed on the system.

- If the installer finds Microsoft NET Framework 1.1 on the system, then the 
Interplay Transfer installation continues.

- If Microsoft NET Framework 1.1 is not found, a license agreement appears. Click 
Yes to accept the license agreement. The Microsoft NET Framework 1.1 begins to 
install.

n If you do not accept the license agreement, the Interplay Transfer Engine installation ends 
without completing.

12. A message appears, asking if you want to open the Avid Interplay Transfer Engine 
Configuration tool now or later.

t Click Yes to open the Avid Interplay Transfer Engine Configuration tool.

n To open the Interplay Transfer Engine Configuration tool after the Interplay Transfer 
installation is complete, click the Start button, and select All Programs > Avid > 
Avid Interplay Transfer Engine Configuration.

13. Set the appropriate options in the Avid Interplay Transfer Engine Configuration tool. 
See “Understanding the Avid Interplay Transfer Engine Configuration Settings” on 
page 38.

14. After you complete the configuration of the server, click Save.

15. Click “Yes, I want to restart my computer now.”

16. Click Finish.
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Installing the Interplay Transfer Client Software

You must install the Interplay Transfer client software on each client in the workgroup that 
plans on transferring Avid assets to another workgroup or playback device. 

n When installing AirSpeed as an Interplay Transfer client, use the Interplay Transfer client 
software provided with this release. Do not install the older version available from the 
AirSpeed I/O application CD-ROM.

To install the Interplay Transfer client software on an Avid editing system:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file.

2. Click Clients on the Main Menu page.

The Install Client Support page opens.

3. Click Avid Editor Support.

The Avid Editor Support page opens.

4. Click Avid Interplay Transfer Client.

5. In the Welcome window, click Next.

6. Click the applicable country, and click Next.

7. Click Yes to accept the license agreement.

n If you do not accept the license agreement, the Interplay Transfer Client installation ends 
without completing.

The Select the Installation dialog box opens.

8. Select Avid Interplay Transfer Client on an Avid editing system, and click Next.

9. Click Next to accept the location for the application.

10. The installer verifies that Microsoft NET Framework 1.1 is installed on the system.

- If the installer finds Microsoft NET Framework 1.1 on the system, then the 
Interplay Transfer installation continues.

- If Microsoft NET Framework 1.1 is not found, follow the instructions to install it.

11. Click “Yes, I want to restart my computer now.”

12. Click Finish.

13. Repeat the installation for each client.

For documentation on configuring the Avid editing system for transfers, see “Configuring 
the Avid Editing Application for Transfers” on page 57.
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Installing Interplay Transfer Support Software

Depending on your workflow and workgroup environment, you might need to install one of 
the Interplay Transfer support software products. If your workflow includes capturing from 
an AirSpeed or AirSPACE, you must install the Avid Interplay Adapter service. If you want 
to monitor transfers from a standalone system, then you should install the Avid Interplay 
Media Services and Transfer Status software.

The following sections provide procedures for installing these software products:

• Installing the Avid Interplay Adapter Service

• Installing the Interplay Media Services and Transfer Status Tool

Installing the Avid Interplay Adapter Service

If your workflow includes capturing from AirSpeeds or AirSPACE, you need to install the 
Avid Interplay Adapter service on the Avid Interplay Server.

To install the Avid Interplay Adapter service on a Avid Interplay Server:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file.

2. Click Servers on the Main Menu page, and then click Avid Interplay Engine.

The Install Avid Interplay Engine page opens.

3. Click Avid Interplay Adapter. 

4. In the Welcome window, click Next.

5. Click the applicable country, and click Next.

6. Click Yes to accept the license agreement.

7. Click Next to accept the location for the application.

The installation begins.

8. In the Installation Complete window, click Finish.

9. Click Exit to close the installer.

The Avid Interplay Adapter service automatically runs in the background.
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Installing the Interplay Media Services and Transfer Status Tool

The Media Services and Transfer Status tool lets you monitor transfers from a standalone 
system. The Media Services and Transfer Status configuration settings only apply to the 
standalone system. These settings do not effect other components in a workgroup.

To install Media Services and Transfer Status software on a standalone system:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file.

2. Click Individual Optional Installers on the opening installation screen.

The Individual Optional Installers page opens.

3. Click Avid Interplay Media Services and Transfer Status.

4. In the Welcome window, click Next.

5. Click the applicable country, and click Next.

6. Click Yes to accept the license agreement.

7. Click Next to accept the location for the application.

The installation begins.

8. Click Finish and Exit to close the installer.

For procedures on configuring the Interplay Media Services and Transfer Status tool, see 
“Configuring a Standalone System to Monitor Transfer Status” on page 53.

Installing the Interplay Transfer Software in a 
Standalone Environment

If you are installing Interplay Transfer for workstation-to-workstation transfers in an 
environment other than Avid Unity, you must install the Interplay Transfer Engine software 
and Interplay Transfer Client software on each client.

The Interplay Transfer Engine software also installs the Interplay Transfer configuration 
software, which lets you set up the particular configuration for your workstation transfers.

n Workstation-to-workstation transfers are not supported with Avid Instinct systems.

For procedures on installing the Interplay Transfer standalone software:

• Installing the Interplay Transfer Engine on a Standalone Editing System

• Installing the Interplay Transfer Client Software in a Standalone Environment
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Installing the Interplay Transfer Engine on a Standalone Editing 
System

To install the Interplay Transfer Engine on an Avid editing system:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file.

2. Click Servers on the Main Menu page, and then click Avid Interplay Transfer Engine.

The Avid Interplay Transfer Engine page opens.

3. Click Avid Interplay Transfer Engine.

4. In the Welcome window, click Next.

5. Click the applicable country, and click Next.

6. Click Yes to accept the license agreement.

7. In the “Choose the installation type that best suits your needs” dialog box, select one of 
the following:

- Avid Interplay Transfer Engine with Supplemented FTP Services – if your 
workgroup configuration includes supported ingest or playback FTP devices, such 
as Sony e-VTR

c Do not install FTP services on a server used with Avid AirSPACE.

- Avid Interplay Transfer Engine – to install the standard Interplay Transfer Engine 
software 

8. Click Next.

9. Click Next to accept the location for the application.

10. The installer verifies that Microsoft NET Framework 1.1 is installed on the system.

- If the installer finds Microsoft NET Framework 1.1 on the system, then the 
Interplay Transfer installation continues.

- If Microsoft NET Framework 1.1 is not found, a license agreement appears. Click 
Yes to accept the license agreement. The Microsoft NET Framework 1.1 begins to 
install.

n If you do not accept the license agreement, the Interplay Transfer Engine installation ends 
without completing.



Installing the Interplay Transfer Software in a Standalone Environment

35

11. A message appears, asking if you want to open the Avid Interplay Transfer Engine 
Configuration tool now or later.

t Click Yes to open the Avid Interplay Transfer Engine Configuration tool.

n To open the Avid Interplay Transfer Engine Configuration tool after the Interplay Transfer 
installation is complete, click the Start button, and select All Programs > Avid > 
Avid Interplay Transfer Engine Configuration.

12. Set the options in the Avid Interplay Transfer Engine Configuration tool. See 
“Understanding the Avid Interplay Transfer Engine Configuration Settings” on page 38.

13. Click Save.

14. Click OK to the message box that indicates changes made to the Interplay Transfer 
configuration will not take effect until the Avid editing system is restarted.

15. Click “Yes, I want to restart my computer now.”

16. Click Finish.

Installing the Interplay Transfer Client Software in a Standalone 
Environment

You must install the Interplay Transfer client software on each standalone client.

To install Interplay Transfer client software in a standalone environment:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file.

2. Click Clients on the Main Menu page.

The Install Client Support page opens.

3. Click Avid Editor Support.

The Avid Editor Support page opens.

4. Click Avid Interplay Transfer Client.

5. In the Welcome window, click Next.

6. Click Yes to accept the license agreement.

7. Click the applicable country, and click Next.

8. Click Next to accept the location for the application.

9. Click Finish to restart.
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Chapter 3

Interplay Transfer Configuration

This chapter describes how to configure the Interplay Transfer server and Interplay Transfer 
clients after you install the software. This chapter describes both an Avid Unity environment 
and a standalone configuration. The Interplay Transfer server is an Avid Unity client in the 
Avid Unity environment.

• Understanding the Avid Interplay Transfer Engine Configuration Settings

• Configuring Transfer Presets

• Configuring an Avid Interplay Workgroup For Transfers

• Configuring a Standalone System to Monitor Transfer Status

• Configuring Interplay Transfer in a Standalone Environment

• Configuring the Avid Editing Application for Transfers

• Configuration for Capturing and Play Back of MXF DHM OPIa File Formats

• Configuration for Capturing From FTP Deck Devices

• Configuring an Ingest Device Catalog

• Configuring a Playback Device Catalog
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Understanding the Avid Interplay Transfer Engine 
Configuration Settings

The Avid Interplay Transfer Engine Configuration dialog box lets you set several options for 
performing various types of media transfers. 

To open the Avid Interplay Transfer Engine Configuration dialog box:

t In a workgroup environment, from the Interplay Transfer server, click the Start button, 
and select All Programs > Avid > Avid Interplay Transfer Engine Configuration.

t In a standalone environment, from an Avid editing system, click the Start button, and 
select All Programs > Avid > Avid Interplay Transfer Engine Configuration.

For information about the options in the Interplay Transfer Engine Configuration dialog box, 
see the following table. For changes to take effect, you must restart the Interplay Transfer 
server, or in a standalone environment restart the Avid editing system.

Avid Interplay Transfer Engine Configuration dialog box
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Avid Interplay Transfer Engine Configuration Settings  

Option Description

Workgroup Settings

Asset manager enable In a workgroup environment, select this option to enable the Avid Interplay 
Engine.

Asset manager hostname In a workgroup environment, type the computer name for the Avid Interplay 
Server associated with the workgroup this Interplay Transfer is attached to.

User name and Password In a workgroup environment, type the user name and password that the Interplay 
Transfer should use to connect to the Avid Interplay Server. This user account 
must already exist on the Avid Interplay Engine. Currently, you must type the 
User name as TransferManager and the password as avid.

Accept incoming workgroup 
transfers without Avid 
Interplay Engine login

In a workgroup environment, select this option if you want to accept incoming 
workgroup transfers even if the Interplay Transfer is not logged in to Avid 
Interplay Engine.

No-login workspace for 
incoming transfers

In a workgroup environment, type the name of the Avid Unity workspace where 
you want the incoming transfers to be sent. This workspace must already exist 
and you must have access to it. If you are performing captures, you must set this 
to an Avid Unity workspace.

Standalone Settings

Accept incoming transfer 
after timeout

In a standalone environment, select this option if you want to accept incoming 
transfers after the set timeout. When you are performing standalone transfer 
operations between clients, the timeout value must be set to less than 15 seconds. 
Avid recommends a timeout value of 10 seconds.

OMF
AAF

In a standalone environment, select either OMF or AAF depending on for the 
type of media files being transferred. 

Directory for incoming 
transfers

In a standalone environment, type the name of the directory where you want 
Interplay Transfer to place the incoming transfers. This directory must be a valid 
media files directory. Click Browse to locate a valid directory. The default 
directory is: The default directories are:

In OMF mode - OMFI MediaFiles

In AAF mode - Avid MediaFiles\MXF\1 

n For better performance when media files grow beyond 10,000 files in the 
primary directory \1, you need to change the Directory for incoming 
transfers to Avid MediaFiles\MXF\2.
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System Settings

Enable auto-cleanup of 
transfer queues

Transfer queues are not automatically deleted from the server system. The 
queues let you see the history of the transfers. Select this option if you want the 
transfer queues cleaned up on a regular basis. The default is to Auto-cleanup 
transfers that are older than 360 minutes (6 hours) and to run the auto-cleanup 
every 12 minutes. 

Server logging off
Standard logging on
Debug logging on

These three options are used for debugging problems. If errors occurred where 
Avid Customer Support needs more information from log files, you might have 
to change this setting. The default is Standard logging on.

Configure FTP Parameters If during the install process, you selected “Interplay Transfer Engine with 
Supplement FTP Services” in the “Choose the installation type that best suits 
your needs” dialog box, you need to configure the FTP parameters. See 
“Configuring an FTP Server, FTP Playback, and FTP Ingest Devices” on 
page 61. All entries must match the device’s setup.

Workgroups

Workgroup transfers enabled In a workgroup environment, select this option to enable workgroup-to-
workgroup transfers.

In a standalone environment, select this option to enable transfers to another 
workstation.

Incoming workgroup transfers 
enabled

In a workgroup environment, select this option to enable transfers from another 
workgroup.

In a standalone environment, select this option to enable transfers from 
another workstation.

Max. simultaneous workgroup 
transfers

Displays the maximum number of simultaneous outgoing workgroup transfers. 
Avid recommends 1.

Directory for temporary 
composition files

Type the directory name where you want temporary files to be placed during the 
capture process or during incoming workgroup transfers. The default directory is 
C:\temp.

Delete temporary composition 
files after transfer

This option is used for diagnostic reasons. Select this option during normal use. 
Avid Customer Support might ask you to deselect this option when 
troubleshooting problems.

Avid Interplay Transfer Engine Configuration Settings (Continued)  

Option Description
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Workgroup names Sets the name of remote workgroups and their Interplay Transfer server. 

n This setting is ignored by Avid Interplay Access, because it has its own 
settings for naming remote workgroups.

Do the following: 

1. Click Add. 

2. In the Workgroup Name text box, type a nickname for the remote 
workgroup. This name can be any name you decide to use for the remote 
workgroup. The name you enter for the workgroup appears in the Transfer 
menu on the Avid editing application.

3. In the Maps to Server Name text box, type the computer name of the 
Interplay Transfer server of the remote workgroup.

Playback

Playback transfers enabled Enables play back transfers. Select this option if your workgroup includes a 
playback device such as an Avid AirSPACE. The recommended maximum 
number of simultaneous transfers is 2.

For a NewsCutter XP system in a LANshare environment, the recommended 
maximum number of play back transfers is 1.

Playback devices Enter the name or names of any playback devices in your workgroup. 

n You do not need to list AirSpeeds here, because AirSpeeds have their own 
Interplay Transfer software and configuration settings. 

For the following devices, do the following:

• For an Avid AirSPACE playback device, type the name of the Interplay 
Transfer server and the name of the playback device. For example, type 
TMserver1/Airspace1.

• For Grass Valley Group Profile® systems, type the computer name of the 
playback device. 

• For Generic FTP playback devices, see “Configuring a Generic FTP 
Playback Device into a Workgroup” on page 64.

(Option) In a workgroup environment, when adding a playback device you can 
associate an Avid Interplay Engine Catalog with the playback device, select 
Enter Playback Catalog Name and type a name for the playback catalog. See 
“Configuring a Playback Device Catalog” on page 74.

Avid Interplay Transfer Engine Configuration Settings (Continued)  

Option Description



 Chapter 3 Interplay Transfer Configuration

42

Ingest

Ingest transfers enabled Enables ingest transfers. Select this option if your workgroup includes an ingest 
device. The recommended maximum number of simultaneous ingest transfers 
is 2.

For a NewsCutter XP system in a LANshare environment, the recommended 
maximum number of ingest transfers is 1.

Ingest devices Enter the name or names of any ingest devices in your workgroup. 

n You do not need to list AirSpeeds here, because AirSpeeds have their own 
Interplay Transfer software and configuration settings.

For the following devices, do the following:

• For an Avid AirSPACE ingest device, make sure the name you type for the 
ingest device matches exactly the name of the ingest device in the AirSPACE 
Mission Control server list.

• For a Generic FTP ingest device, see “Configuring a Generic FTP Ingest 
Device into a Workgroup” on page 65.

• For adding a FTP ingest device, type the name associated with the ingest 
device. See “Adding FTP Ingest Devices into an Interplay Transfer Engine 
Configuration” on page 70.

• (Option) In a workgroup environment, when adding an ingest device you can 
associate a Avid Interplay Engine Catalog with the ingest device, select Enter 
Ingest Catalog Name and type a name for the ingest catalog. See 
“Configuring an Ingest Device Catalog” on page 72.

Dynamically Extensible 
Transfers (DET)

Max. DET push transfers Sets the maximum number of simultaneous DET push transfers; Avid 
recommends 4.

Max. DET pull transfers Sets the maximum number of simultaneous DET pull transfers; Avid 
recommends 4.

Avid Interplay Transfer Engine Configuration Settings (Continued)  

Option Description
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Total Transfers 
(All Types)

Sets the maximum number of simultaneous transfers.

In a workgroup environment, this number should be the number of playback 
devices, plus 2 times the number of ingest devices, plus the number of 
workgroups.

In a standalone environment, this number should be at least the total of the 
simultaneous play back transfers plus 2 times the ingest transfers.

For a NewsCutter XP system in a LANshare environment, the recommended 
maximum number of simultaneous transfers is 2.

n The higher the number of simultaneous transfers, the more the impact 
on performance.

Playlist Information

Use Newsroom rundowns to 
schedule transfers

Enables the Interplay Transfer Newsroom rundown scheduling feature. See 
“Working with Rundowns” on page 82.

Newsroom Server Type the computer name of the Newsroom Server.

User Name Type the user name that Interplay Transfer should use to connect to the 
Newsroom Server.

Password Type the password Interplay Transfer should use to connect to the Newsroom 
Server.

Schedule File Name Type the file name of the schedule file that Interplay Transfer should use to 
determine which rundown to use at which time. See “Working with Rundowns” 
on page 82.

Avid Interplay Transfer Engine Configuration Settings (Continued)  

Option Description
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Configuring Transfer Presets

When performing workgroup transfers you can use presets to select a predefined destination 
for the transferring assets. Transfer presets define the remote workgroup, a destination 
workspace, and a destination folder for the metadata. You can also choose whether to display 
the preset name in the Send to Workgroup dialog box.

When setting up a workgroup transfer preset the available choices depend on the type of 
remote workgroup transfer. For example:

• If the remote workgroup is an Avid MediaManager, you might be able to select a 
workspace but cannot select a destination folder.

• If the transfer is a Standalone Transfer Engine, you cannot select a workspace or a 
destination folder.

To configure a transfer preset:

1. Click Start and select All Programs > Avid Interplay Access > Avid Interplay 
Administrator.

The Avid Interplay Server Login dialog box opens.

2. Select an Avid Interplay Server, type a username, and password.

3. Click Connect.

The Avid Interplay Administrator opens.

4. In the Site Settings area, click Workgroup Transfer Presets.

The Workgroup Transfer Presets view opens.
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5. Click Add below the Presets list.

Untitled displays in the Name text box.

6. Type a name for the preset in the Name text box.

7. Select the remote workgroup server from the Remote Workgroup menu.

n The remote workgroup servers available from the Remote Workgroup menu are defined in 
the Configure Remote Workgroups view of the Avid Interplay Administrator. For information 
on adding a remote workgroup to the Remote Workgroup menu, see the Avid Interplay 
Engine and Avid Interplay Access Administration Guide.

8. (Option) Select Workspace and select a destination workspace for the media files from 
the Workspace menu.

If you do not select a workspace, the default destination workspace is used.

Presets list Name text box
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9. (Option) Select Destination and select a destination folder in the remote workgroup 
database for the metadata.

If you do not select a folder, the default destination folder is used.

10. (Option) Select Enabled, if you want this preset to display in the Send to Workgroup 
dialog box.

11. Click Apply to save your changes.

Configuring an Avid Interplay Workgroup For 
Transfers

The Avid Interplay Administrator provides Interplay Transfer site settings for registering 
Interplay Transfer engines, AirSpeeds, and other Interplay Transfer enabled devices in an 
workgroup. After an Interplay Transfer engine is registered, you can access it from any 
Interplay Transfer client in the workgroup. The type of transfers a server or device can 
perform, depends on the transfer settings.

The Interplay Transfer Settings let you:

• Select a cache engine for monitoring various Interplay Transfers. You can choose which 
Interplay Transfer engines and Interplay Transfer enabled devices are monitored by a 
cache engine. See “Selecting a Cache Engine for Monitoring Transfers” on page 48.

• Add an AirSpeed Studio that simultaneously distributes a Send to Playback request to 
multiple AirSpeeds. See “Adding a Studio” on page 51.

• Configure a Studio to allow Send to Playback requests to individual AirSpeeds in the 
Studio.

• List the transfer devices in the various Send to menus.

• Set the length of time between refreshing the Transfer Status view. See “Setting the 
Refresh Time of the Interplay Transfer Status Window” on page 53.

Opening the Interplay Transfer Settings View

The Interplay Transfer Settings are available from the Avid Interplay Administrator.

To open the Interplay Transfer Settings View:

1. Click Start and select All Programs > Avid Interplay Access > Avid Interplay 
Administrator.

The Avid Interplay Engine Login dialog box opens.

2. Select an Avid Interplay Server, type a username, and password.
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3. Click Connect.

The Avid Interplay Administrator opens.

4. In the Site Settings area, click Interplay Transfer Settings.

The Interplay Transfer Settings view opens.

n The Cache Engine listed in the Cache Hostname text box monitors all items listed in the 
Transfer Engines list.

List of 
Cache 
Engines

List of Transfer Engines
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Selecting a Cache Engine for Monitoring Transfers

The cache engine you select to monitor transfers can be located on an Interplay Transfer 
server or on a separate server (a server other than the servers performing the transfers). A 
typical configuration for monitoring transfers uses the cache engine located on the Interplay 
Transfer server. 

When monitoring transfers, you might want to select a cache engine on a separate server to 
improve transfer performance. Monitoring transfers can be resource intensive for a cache 
engine and might impact transfer performance. Depending on the activity of your 
workgroup, the following actions can impact transfer performance:

• Performing a large number of transfers with the Interplay Transfer Engine

• Transferring a large amount of data with the Interplay Transfer Engine

• Monitoring several Interplay Transfer Engines through the cache engine

• Monitoring several Interplay Transfer enabled devices

• Connecting several status clients to the cache engine

By default, to improve performance, the cache engine only polls the status of transfers when 
a client request status of the Interplay Transfer.

A cache engine installs automatically when you install the Interplay Transfer Engine. The 
cache engine starts on the server when you start the Microsoft Windows operating system. 
Therefore, starting the Interplay Transfer Engine is not required to use the cache engine.

n A cache engine is not installed on AirSpeeds. To monitor AirSpeed transfers, you must use a 
cache engine located on a separate server.
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To establish a cache engine for monitoring transfers:

1. Open the Interplay Transfer Settings view. See “Opening the Interplay Transfer Settings 
View” on page 46.

2. Below the Cache Engines list, click Add to add a new Cache engine to the list. 

3. Change the default cache engine name, do the following:

a. In the Cache Hostname text box, type the hostname of the server you want to use for 
monitoring transfers.

b. Press Enter.

The default cache name is replaced with the hostname you typed in the Cache 
Hostname text box.

4. Create a list of the Interplay Transfer Engines and Studios that you want to monitor 
through the cache engine.

t To add Interplay Transfer Engines, see “Adding Interplay Transfer Engines” on 
page 50.

t To add a Studio, see “Adding a Studio” on page 51.

n If the cache engine is located on an Interplay Transfer server, you must add the cache 
engine’s hostname to the Transfer Engines list.
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Adding Interplay Transfer Engines

The cache engine listed in the Cache Hostname text box monitors all transfers handled by 
the Interplay Transfers listed in the Transfer Engines list. 

You can add Interplay Transfer Engines, AirSpeeds, or other Interplay Transfer enabled 
devices using the following procedure. For a procedure to add a Studio to the list, see 
“Adding a Studio” on page 51.

To add an Interplay Transfer Engine or Interplay Transfer enabled device to the 
Transfer Engines list:

1. Open the Interplay Transfer Settings view. See “Opening the Interplay Transfer Settings 
View” on page 46.

2. Establish a cache engine for monitoring transfers. See “Selecting a Cache Engine for 
Monitoring Transfers” on page 48.

3. In the Transfer Engines area of the Interplay Transfer Settings view, click Add.

A default name displays in the Transfer Engines list.

4. In the Transfer Engine Details area, from the Type menu, select Transfer Engine.

5. In the Hostname text box, change the default name by typing the hostname of the 
Interplay Transfer server or Interplay Transfer enabled device that you want to add. 

6. Press Enter.

In the Transfer Engines list, the default name is replaced with the hostname you typed in 
the Hostname text box.

Transfer 
Engines list
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7. From the Workgroup Transfers menu, select the type of workgroup transfers allowed by 
this server or device:

t For an Interplay Transfer Engine, select either Send Only, Receive Only, Send and 
Receive, or No.

n For Interplay Transfer Engines, the Workgroup Transfers setting only effects workgroup 
transfers that are initiated from the Avid Interplay Access or by dragging a Workgroup 4.5 
asset into the Interplay TransferStatus View. This setting has no effect on transfers initiated 
from Avid editing systems.

t For an Interplay Transfer enabled device, such as an AirSpeed, select No. 

Workgroup transfers are not allowed by these devices.

8. (Option) If you want an Interplay Transfer Engine to be the primary Interplay Transfer 
Engine used by the Avid editing systems, then select “Primary Transfer Engine for 
Editors.”

n Each workgroup can have only one primary Interplay Transfer Engine. Workgroup transfers 
are handled by the primary Interplay Transfer Engine. Therefore, only Interplay Transfer 
Engines are allowed to be the primary Interplay Transfer.

9. Click Apply when you finish adding all the Interplay Transfer Engines to the list.

Adding a Studio

An AirSpeed Studio is a group of AirSpeeds that simultaneously processes Send to Playback 
requests. In a workgroup, a cache engine can monitor the transfers handled by the Studio 
members. When you add a Studio to a workgroup, you can choose whether to list the 
individual members of the Studio in the Send to Playback menu.

To add a Studio to the Transfer Engines list:

1. Open the Interplay Transfer Settings view. See “Opening the Interplay Transfer Settings 
View” on page 46.

2. Establish a cache engine for monitoring transfers. See “Selecting a Cache Engine for 
Monitoring Transfers” on page 48.

3. In the Transfer Engines area of the Interplay Transfer Settings view, click Add.

A default name displays in the Transfer Engines list.
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4. In the Transfer Engine Details area, from the Type menu, select Studio.

The default name is appended with [1] indicating it is a Studio.

A Studio is identified using the following naming convention: studioname[N]

In this example, studioname is the Host Name assigned in the AirSpeed application, and 
N represents the number of members in the Studio.

For more information about naming and configuring the AirSpeed and Studio, see the 
AirSpeed documentation.

5. In the Studio Name text box, change the default name by typing the hostname of the 
Studio.

6. Click the Transfer Engines list.

The default name is replaced with the hostname you typed in the Studio Name text box.

7. In the Studio Host Count menu, select the number of members in the Studio.

The maximum number of Studio members is 5.

8. Press Enter. 

The number you selected is appended to the Studio name. For example, if you select 3, 
the Studio name appears as Studioname[3].
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9. (Option) If you want each Studio member to display in the Send to Playback menu, 
select “Show individual studio hosts in the Send To Playback choices.”

10. Click Apply when you finish adding all the Studios to the Transfer Engines list.

Setting the Refresh Time of the Interplay Transfer Status Window

You can adjust the amount of time between refreshes of the Interplay Transfer Status 
window.

n This setting does not impact how frequently the cache engine polls the Avid Interplay 
Engine.

To set the Interplay Transfer Status view refresh time:

1. Open the Interplay Transfer Settings view. See “Opening the Interplay Transfer Settings 
View” on page 46.

2. In the Refresh Interval (ms) text box, type the amount of time you want between 
refreshes of the status view. The unit is millisecond (ms).

3. Click Apply.

Configuring a Standalone System to Monitor 
Transfer Status

The Avid Interplay Media Services and Transfer Status tool lets you monitor transfers and 
services of various workgroups and servers from a standalone system. After you install the 
application on a standalone system, you need to configure the Media Services and Transfer 
Status settings. 

n For installation procedures, see “Installing the Interplay Media Services and Transfer Status 
Tool” on page 33.

Any changes you make to the configuration settings apply only to the standalone system. 
They do not effect other components in a workgroup.

To configure a standalone system for monitoring transfers:

1. Click Start and select All Programs > Avid > Avid Interplay Media Services and 
Transfer Status.

The Avid Interplay Media Services and Transfer Status tool opens.
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2. Click the Transfer tab.

3. Click Configure Workgroups.

The Configure Workgroups dialog box opens.
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4. To add a workgroup you want to monitor, do the following:

a. Click + below the Workgroups list.

b. Change the default workgroup name by typing the name of the workgroup you want 
to monitor in the Workgroup Name text box.

c. Press Enter.

The default name is replaced with the workgroup name you typed. 

n The workgroups displayed in the Workgroups list appear in the Workgroup menu on the 
Transfer tab of the Avid Interplay Media Services and Transfer Status tool.

5. Set the various settings to select a cache host and add Interplay Transfer Engines and 
Interplay Transfer enabled devices to the monitoring list. These settings are similar to 
the settings in the Interplay Transfer Settings view, except that the Primary Transfer 
Engine and the Refresh Interval options are not available. For procedures that explain 
these settings, see “Selecting a Cache Engine for Monitoring Transfers” on page 48.

6. Click Save.

Add a 
Workgroup

Workgroups 
list
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Monitoring Transfer Status from a Standalone System

To monitor transfers from a standalone system:

1. Click Start and select All Programs > Avid > Avid Interplay Media Services and 
Transfer Status.

The Avid Interplay Media Services and Transfer Status tool opens.

2. Click the Transfer tab.

3. From the Workgroup menu, select the workgroup you want to monitor.

4. Click Connect.

The status view opens.

For descriptions of the status components, see “Understanding the Interplay Transfer Status 
Window” on page 97.
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Configuring Interplay Transfer in a Standalone 
Environment

If you are installing Interplay Transfer for workstation-to-workstation transfers in an 
environment other than Avid Unity, you must install the Interplay Transfer Engine on each 
client. For information on installing the Interplay Transfer software in standalone 
environments, see “Installing the Interplay Transfer Software in a Standalone Environment” 
on page 33.

This software installs the Interplay Transfer Engine configuration software that lets you set 
up the particular configuration for transfers from your Avid editing system. For descriptions 
of the various settings on the Interplay Transfer Engine Configuration window, see 
“Understanding the Avid Interplay Transfer Engine Configuration Settings” on page 38.

You must install the Interplay Transfer client software on each standalone client. For 
information about installing the Interplay Transfer client software, see “Installing the 
Interplay Transfer Client Software in a Standalone Environment” on page 35. 

Configuring the Avid Editing Application for 
Transfers

After you install the Interplay Transfer client software on an Avid editing system, you can 
configure the transfer process.

For procedures on configuring the Avid editing application for transfers, see the following 
topics:

• Setting Transfer Settings in the Avid Editing Application

• Allowing Transfers to Other Workgroups and Workstations

Setting Transfer Settings in the Avid Editing Application

To activate Interplay Transfer each time you start your Avid editing application and to 
have the application notify you of incoming transfers:

1. In the Avid editing application, click the Settings tab in the Project window.

2. Double-click Transfer in the Settings list.

The Transfer Settings dialog box opens.

3. Click the Settings tab.



 Chapter 3 Interplay Transfer Configuration

58

4. In the Standalone/Incoming Requests area, do one of the following:

t Select “Refuse All Requests,” if you do not want to receive files from another 
workgroup. 

t Select “User Dialog To Accept/Refuse,” and one of the following methods for 
accepting transfers:

Wait for User Action (No Timeout) — You receive a message request for a transfer. 
You must click OK for the transfer to occur.

Accept After Timeout — The system automatically accepts the file after the 
timeout.

Refuse After Timeout — The system does not accept the file after the timeout.

In the Timeout (seconds) text box, type the amount of time you want to set for the 
timeout.

5. In the Status Window area, do the following:

a. In the text box, type the number of seconds you want the status window to update.

b. (Option) Select “Bring up window if error occurs” if you want errors to display.
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6. (Option) In a workgroup environment, if you want mixed-resolution items highlighted 
in the bin, select “Highlight mixed-resolution items” in the Send to Playback area.

If a sequence contains DV 25 and DV 50 media within the same sequence, that sequence 
is highlighted in red in the bin. Interplay Transfer cannot send sequences that contain 
both DV 25 and DV 50 media to playback. This feature allows you to easily identify 
those sequences.

7. In the Output Audio Mix area, select the type of audio output you want.

- Direct channel output - Send to Playback transfers audio tracks without performing 
a mixdown.

- Stereo output - Send to Playback mixes all of the tracks to a stereo pair, using pan 
controls to split the tracks. The sequence is copied before the mixdown is edited in, 
and the suffix .transfer is added to the name (same as in the direct output option).

8. Click OK.

Allowing Transfers to Other Workgroups and Workstations

Depending on your environment, you can transfer items to other workgroups and 
workstations that have Interplay Transfer software installed.

To allow transfers to other workgroups and workstations:

1. In the Avid editing application, click the Settings tab in the Project window.

2. Double-click Transfer in the Settings list.

The Transfer Settings dialog box opens.

3. Click the TMClient.ini tab.
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4. Do one of the following:

t In a workgroup environment, type the Interplay Transfer server computer name in 
the Server text box, and type the name of your workgroup in the Workgroup text 
box. This can be any name you give your workgroup.

t In a standalone environment, type the computer name of the local system (this 
computer) in the Server text box, and in the Workgroup text box, type the name you 
want to see in the Transfer menu.

5. In the Other Workgroups area, click Add. 

The Add Workgroup To List dialog box opens.

6. Do one of the following:

t In a workgroup environment, type the name of the other Interplay Transfer server in 
the Server text box, and type the name of the other workgroup in the Workgroup 
text box.

t In a standalone environment, in the Server text box, type the computer name of 
other workstation, and in the Workgroup text box, type the name you want to see in 
the Transfer menu.

7. Click OK.

The name you typed displays in the Other Workgroups list.

n If you want to edit the names of any of the Interplay Transfer servers or workstations listed 
in the Other Workgroups area, select the name, click Edit, and make the changes.
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Configuration for Capturing and Play Back of MXF 
DHM OPIa File Formats

To enable interoperability between Avid Unity family and third-party devices that use the 
MXF OP1a file format, Avid has developed an optional Avid Interplay Transfer Data 
Handling Module (DHM) plug-in that supports FTP integration to third-party MXF OP1a 
compliant devices. The Interplay Transfer MXF OP1a FTP DHM allows MXF OP1a files to 
be brought into an Avid Unity, Avid Unity ISIS, or an Avid editing environment from an 
FTP server. You can also export Avid media files in MXF OP1a format to an FTP server 
using this same MXF OP1a FTP DHM.

When adding a Thunder production server, you need to perform some specific procedures in 
addition to the procedure in this section. For more information, see “Adding a Thunder 
Production Server” on page 68.

You must do the following to integrate a FTP server into a workgroup:

• Select “Interplay Transfer Engine with Supplemental FTP Services” as the installation 
type when installing the Interplay Transfer Engine application. See “Installing the 
Interplay Transfer Engine in a Workgroup Environment” on page 28.

n After the installation, you can verify the FTP DHM is installed by using the Dongle Dumper. 
To open the Dongle Dumper, navigate to C:\Program Files\Avid\Utilities\Dongle Dumper.

• Configure the FTP parameters for the FTP server. See “Configuring the FTP Parameters 
for an FTP Server” on page 62.

• Configure an FTP playback device using the Avid Interplay Transfer Engine 
Configuration dialog box. See “Configuring a Generic FTP Playback Device into a 
Workgroup” on page 64.

• Configure an FTP ingest device using the Avid Interplay Transfer Engine Configuration 
dialog box. See “Configuring a Generic FTP Ingest Device into a Workgroup” on 
page 65.

• Create an FTP directory profile. See “Creating and Editing FTP Directory Profiles” on 
page 66.

For FTP transfer procedures, see “Transferring To and From Generic FTP Servers” on 
page 85.

Configuring an FTP Server, FTP Playback, and FTP Ingest Devices

The Avid Interplay Transfer Engine Configuration dialog box provides areas for configuring 
an FTP server, FTP playback, and FTP ingest devices.
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For information about adding a Thunder MX production server, see “Adding a Thunder 
Production Server” on page 68.

Configuring the FTP Parameters for an FTP Server

When adding an FTP server to your workgroup environment, you need to configure the 
server’s FTP parameters.

n After you configure the FTP parameters for the FTP server, you can not edit the Profile 
Name, Default Directory, or FTP Mode settings. If you need to change these settings, you 
will need to create a new profile for the FTP server.

To configure FTP servers in a workgroup:

1. On your Interplay Transfer server, click the Start button, and select All Programs > 
Avid > Avid Interplay Transfer Engine Configuration.

The Avid Interplay Transfer Engine Configuration dialog box opens.

2. Click the Configure FTP Parameters button.

The Configure FTP dialog box opens.

n If the Configure FTP Parameters button is not available, then “Interplay Transfer Engine 
with Supplemental FTP Services” was not selected as the installation type when the 
Interplay Transfer Engine application was installed.
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3. Click Add.

The FTP Server dialog box opens.

4. Enter the following setup information for the FTP server you are configuring:

FTP Server configuration  

Setting Description

Profile Name Type a name of this profile. 

n The name you assign to the profile appears in the 
FTP Media Browser.

Server Name Type the name of the FTP server.

Username Type the user name used to connect to the FTP server.

Password Type the password used to connect to the FTP server.

Server Type Select the type of server in the workgroup: 
GENERIC_FTP_PROFILE, MEDIA_STREAM_PROFILE, 
OMNEON_SERVER_PROFILE.
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5. Click OK.

6. On the Configure FTP dialog box, type the port number in the Generic FTP Port text 
box.

7. Click Done.

Configuring a Generic FTP Playback Device into a Workgroup

When adding a Generic FTP playback device into your workgroup environment, you need to 
configure the device using the Interplay Transfer Engine Configuration dialog box.

To add a generic FTP playback device into a workgroup:

1. On your Interplay Transfer server, click the Start button, and select All Programs > 
Avid > Avid Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration dialog box opens.

2. In the Playback area, click Add.

The Device dialog box opens.

FTP Connection Information

Default Directory Displays the directory on the FTP server where data is sent to or 
retrieved from.

FTP Mode Displays the FTP mode as active.

FTP Port Address Type the FTP connection port. The default is 21.

FTP Server configuration (Continued)  

Setting Description
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3. Type the name associated with the Generic FTP playback device on the network, for 
example: bdctm1:6534/anything, where

- bdctm1 is the Interplay Transfer server name

- 6534 is the Generic FTP port address for the playback device

n The port number used for the playback device must match the Generic FTP Port number on 
the Configure FTP dialog box. See “Configuring the FTP Parameters for an FTP Server” 
on page 62.

- anything is the FTP profile name that contains the information required to connect 
to a particular directory on a FTP server. See “Creating and Editing FTP Directory 
Profiles” on page 66.

4. (Option) You can assign a playback catalog for transfers; see “Configuring a Playback 
Device Catalog” on page 74.

5. Click OK.

6. Click Save.

Configuring a Generic FTP Ingest Device into a Workgroup

When adding a Generic FTP ingest device into your workgroup environment, you need to 
configure the device using the Avid Interplay Transfer Engine Configuration dialog box.

To add a Generic FTP ingest device into a workgroup:

1. On your Interplay Transfer server, click the Start button, and then select All Programs > 
Avid > Avid Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration dialog box opens.

2. In the Ingest area, click Add.

The Device dialog box opens.
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3. Type the name of the FTP profile that contains the information required to connect to a 
particular directory on a FTP server. See “Creating and Editing FTP Directory Profiles” 
on page 66.

n When adding an ingest device, you do not need to type the host name or the port address of 
the Interplay Transfer server.

4. Click OK.

5. Click Save.

Creating and Editing FTP Directory Profiles

When a workgroup includes an FTP server, you need to create FTP directory profiles that 
allow the FTP server to connect with the Avid editing system.

To create and edit FTP server profiles:

1. From the Avid editing system, click the Start button, and then select All Programs > 
Avid > Utilities > Avid FTP Media Browser.

The Avid - FTP Media Browser opens.

Profile list
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2. Right-click the Profile list.

The FTP Source Window opens, providing a list of FTP directory profiles.

3. Do one of the following:

t Click Add to add a new profile.

t Select a Profile Name and click Edit to edit an existing profile.

The Ftp Directory Profile Window opens.
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4. Enter the following configuration information for the FTP server:

n Your entries must match the FTP server’s network settings.

5. (Option) Click Test Connection if you want to verify that the connection to the FTP 
directory is working.

6. Click Save.

Adding a Thunder Production Server
To configure the Interplay Transfer Engine to add a Thunder production server, follow the 
procedures for configuring a Generic FTP device. For the procedures, see “Configuration for 
Capturing and Play Back of MXF DHM OPIa File Formats” on page 61.

In addition to these configuration procedures, the Thunder server needs an ImportWatcher 
folder to hold the files during transfers from the Avid editing system. After the transfers are 
complete the files are moved from the ImportWatcher folder to the Clip folder in the 
Thunder server’s database. The files in the Clip folder are used during a transfer from the 
Thunder server to the Avid editing system.

Ftp Directory Profile Window Settings  

Setting Description

Profile Name Name of this profile. A unique profile name is used for each directory.

Connection Port Displays the port number used by the FTP server.

FTP Host Name Type the FTP server’s network name. This FTP host name must match the 
server name assigned during the configuration of the FTP parameter. See 
“Configuring the FTP Parameters for an FTP Server” on page 62.

User Name Type your user name.

Password Type the FTP server’s password.

Directory Path Displays the default directory where the source media is located on the 
FTP server.

Server Type Select the type of server in the workgroup: GENERIC_FTP_PROFILE, 
MEDIA_STREAM_PROFILE, OMNEON_SERVER_PROFILE.

FTP Mode Displays the FTP mode as Passive.
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n To transfer files to or from a Thunder server, the Interplay Transfer Engine requires the 
“Avid Interplay Transfer Server with Supplemental FTP Services” option during 
installation. 

Before you can transfer files, the Thunder server requires the following setup. For 
procedures, see the Thunder documentation:

• Verify the Thunder server has at least one database.

• Verify the Thunder server and all Avid editing systems have the same timecode settings 
(Drop Frame or non-Drop Frame) and video standard (NTSC or PAL).

• Setup and enable the ImportWatcher folder.

• Install and configure the third-party FTP server software to create a Send user and a 
Retrieve user that match the users set up on the Avid editing system. 

For procedures on how to transfer files to and from a Thunder server, see “Transferring To 
and From Generic FTP Servers” on page 85. 

Configuration for Capturing From FTP Deck 
Devices

TM-DHM is Avid’s API to integrate with third-party video server vendors. Avid has written 
its own integration to the DHM API for the Sony e-VTR and XDCAM deck devices. The 
integration supports MXF files by rewrapping them in AAF (MXF workgroup) as they are 
brought into Avid Unity shared storage through the Interplay Transfer server. You need to 
configure the FTP deck device before you can capture media from it. For procedures on how 
to capture clips, see “Capturing From FTP Deck Devices” on page 89.

The following configuration and setup steps are required to integrate a FTP device into a 
workgroup:

1. Select “Interplay Transfer Engine with Supplemental FTP Services” as the installation 
type when installing the Interplay Transfer Engine application. See “Installing the 
Interplay Transfer Engine in a Workgroup Environment” on page 28.

2. Add the ingest device to the Interplay Transfer configuration. See “Adding FTP Ingest 
Devices into an Interplay Transfer Engine Configuration” on page 70.

3. Set up the device connection from the Avid editing system. For the connection setup 
procedure, see “Setting the Ingest Device Connection” on page 71.

4. Capture the clips from a FTP device. See “Capturing From FTP Deck Devices” on 
page 89.
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Adding FTP Ingest Devices into an Interplay Transfer Engine 
Configuration

When configuring an FTP ingest device into your workgroup environment, you need to add 
the device to the Interplay Transfer server configuration.

To add an FTP ingest device to your Interplay Transfer server configuration:

1. On the Interplay Transfer server, click the Start button, and then select All Programs > 
Avid > Avid Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

2. In the Ingest area, click Add.

3. In the Device dialog box, type the name associated with the ingest device on the 
network, for example evtr_wu.

4. Click OK.

5. (Option) Add an ingest catalog. See “Configuring an Ingest Device Catalog” on 
page 72.

6. Make sure the Workgroup Settings are set correctly. See the table in “Understanding the 
Avid Interplay Transfer Engine Configuration Settings” on page 38.

7. Click Save.
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Setting the Ingest Device Connection

When a workgroup includes an FTP device, you need to set the device connection from the 
Avid editing system.

To set up a connection to ingest from FTP devices, such as a Sony e-VTR:

1. From the Avid editing system, click the Start button, and then select All Programs > 
Avid > Utilities > FTPClipList.

The FTPClipList dialog box opens.

2. Click Configure.

The Connection Settings dialog box opens.
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3. Enter the following setup information for the device you are configuring:

n Your entries must match the device’s network settings.

4. Click OK.

Configuring an Ingest Device Catalog

When configuring an ingest device into your workgroup environment, you can associate a 
Avid Interplay Access Catalog with the ingest device. The ingest catalog contains master 
clips of the media created during successful ingest transfers. You can associate more than 
one ingest device to a catalog. The ingest catalog is a regular Avid Interplay Access catalog 
using the same display, access control, and delete rules. 

When the first ingest occurs after you set up an ingest catalog, the Interplay Transfer creates 
the catalog in the Avid Interplay Access tree view.

Associating a catalog with an ingest device does not effect the usual process of checking in 
ingested clips to a workspace.

n The ingest catalog feature is not available with AirSpeed.

Connection Settings Dialog Box  

Setting Description

Host Name Device’s network server name. This host name must match the host name 
listed in the ingest device list in the Avid Interplay Transfer Engine 
Configuration window.

Login Device’s login name.

Password Device’s password.

Directory Displays the default directory where the source media is located on the FTP 
device for ingesting.

Device Type Select the type of device.

Video Rate Select the video rate - either IMX 30, 40, 50, or DVCam. Your selection 
must match the set rate of the device.

Signal Standard Select PAL or NTSC. Your selection must match the setting of the device.

Audio Tracks Select the number of audio tracks you want to ingest (2, 4, 6, or 8).
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To associate a Avid Interplay Access Catalog with an ingest device:

1. On the Interplay Transfer server, click Start, and then select All Programs > Avid > Avid 
Interplay Transfer Engine Configuration.

2. In the Ingest area, select an ingest device and click Edit.

The Device dialog box opens.

3. Select Enter Ingest Catalog name.

4. Type a name for the ingest catalog.

The catalog name you enter will display in the Avid Interplay Access when the first 
ingest occurs.

5. Click OK.

The catalog name displays inside square brackets and next to the ingest device name.

For example, HKELLYHPXP [Cat1], where HKELLYHPXP is the ingest device name 
and Cat1 is the catalog name.

6. Click Save.

7. Restart the Interplay Transfer server.
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Configuring a Playback Device Catalog

When configuring a playback device into your workgroup environment, you can associate a 
Avid Interplay Access Catalog with the playback device. The playback catalog contains 
clips of the media and all its relatives, including the .transfer sequences, that successfully 
transfer to the playback device. You can associate more than one playback device to a 
catalog. The playback catalog is a regular Avid Interplay Access catalog using the same 
rules for display, access control, and delete. 

n The playback catalog feature is not available with AirSpeed.

To associate a Avid Interplay Access Catalog with a playback device:

1. On the Interplay Transfer server, click Start then select All Programs > Avid > Avid 
Interplay Transfer Engine Configuration.

2. In the Playback area, select a playback device and click Edit.

The Device dialog box opens.

3. Select Enter Playback Catalog name.

4. Type a name for the playback catalog.

The catalog name you enter will display in the Avid Interplay Access Catalog when the 
first transfer occurs.

5. Click OK.

6. Click Save.

7. Restart the Interplay Transfer server.
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Transferring Avid Assets

This chapter describes how to transfer Avid assets. You can transfer assets to another 
workgroup or to any supported media servers.

Before you can transfer assets, you must configure the Interplay Transfer components. For 
configuration procedures, see “Interplay Transfer Configuration” on page 37.

This chapter discusses the following topics:

• Media Compatibility Between Avid Applications

• Transferring Avid Assets from Within an Avid Editing Application to Another 
Workgroup

• Transferring Avid Assets from a Remote Workgroup to Your Avid Editing System

• Transferring Avid Assets from Workgroup to Workgroup

• Transferring Avid Assets in a Standalone Environment

• Transferring Avid Assets to a Playback Device

• Transferring Files from an Ingest Device

• Transferring To and From Generic FTP Servers

• Capturing From FTP Deck Devices
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Media Compatibility Between Avid Applications

The type of system on which your application is running determines what can be sent 
between systems. Before you transfer data between Avid applications, consider whether the 
media files, metadata, or compositions are compatible between applications.

For additional information about compatibility, see the documentation provided with your 
Avid editing system.

Transferring Avid Assets from Within an Avid 
Editing Application to Another Workgroup

If Interplay Transfer is properly installed and enabled on your Avid editing system, it starts 
automatically whenever you start the Avid editing application. When you complete a 
sequence, you can transfer it from the Avid editing application to any other connected 
workgroup or to a playback device. Once you send the sequence, you can work on another 
project while the transfer is taking place.

For information about configuring the Avid editing application for transferring assets, see 
“Configuring the Avid Editing Application for Transfers” on page 57.

Transferring Avid Assets From an Avid Editing Application

To send clips or sequences to another workgroup from within the Avid editing 
application:

1. Open the bin that contains the clips or sequences you want to send.

2. Select a clip or sequence, or Ctrl+click multiple clips or sequences.

3. Select Transfer > Send To Workgroup and then select the available workgroup to which 
you want to send the assets.

The assets are sent to the Interplay Transfer server, where they are then sent to the 
selected workgroup. You can now work on another project while the transfer is taking 
place.

For information on monitoring the transfer of assets, see “Monitoring Transfers from 
Within the Avid Editing Application” on page 94.
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Transferring Avid Assets from a Remote 
Workgroup to Your Avid Editing System

Interplay Transfer lets you move assets from a remote workgroup to your Avid editing 
system bin. To “pull” assets from the external workgroup, you must use the Avid Interplay 
Access from the originating workgroup. You drag the assets from the remote Avid Interplay 
Access and drop them in the Avid editing system bin.

To transfer assets from a remote workgroup to your Avid editing system:

1. In the Avid Interplay Administrator on the Avid editing system, make sure the remote 
workgroup is configured for access. See “Configure Remote Workgroups” in the Avid 
Interplay Engine and Avid Interplay Access Administration Guide.

2. Open the Avid editing bin in which you want to store the Avid assets that you want to 
transfer.

3. Perform a search operation that returns the assets that you want to transfer.

4. In the search area, click the assets, or Ctrl+click multiple assets that you want to transfer 
and drag them to the Avid editing bin.

The imported assets appear in the bin. To monitor the transfer, see “Monitoring 
Transfers” on page 93.

Transferring Avid Assets from Workgroup to 
Workgroup

This section explains how to transfer assets from one workgroup to another workgroup. If 
you want to transfer assets to another workgroup, you must have the Interplay Transfer 
application installed in the workgroup.  

Types of workgroup transfers:

• Transferring Avid Assets from an Interplay Workgroup to Another Interplay Workgroup

• Transferring Avid Assets from Workgroup 4.5 to an Interplay Workgroup

n Transfers from Avid Interplay to Workgroup 4.5 OMF are not supported.



 Chapter 4 Transferring Avid Assets

78

Transferring Avid Assets from an Interplay Workgroup to Another 
Interplay Workgroup

The Avid Interplay Access lets you use Interplay Transfer to transfer assets from one 
workgroup to another. You can use presets to select a predefined destination for the 
transferring assets. For procedures on configuring transfer presets, see “Configuring 
Transfer Presets” on page 44.

Before you can transfer assets to another workgroup, the other workgroup must be 
configured in the Configure Remote Workgroups view in the Avid Interplay Administrator. 
All configured remote workgroups display in the Destination tree of the Send to Workgroup 
dialog box. For information about registering a remote workgroup, see the Avid Interplay 
Engine and Avid Interplay Access Administration Guide.

To transfer Avid assets to another Interplay workgroup:

1. If you have not already done so, start your local Avid Interplay Access. 

t Click Start and select All Programs > Avid Interplay Access > Avid Interplay 
Access.

2. Start the remote Avid Interplay Access.

3. In your local Avid Interplay Access, select the assets that you want to transfer to the 
remote Avid Interplay Access.

n The assets you select must be Avid assets. You cannot transfer file assets, such as folders or 
graphic files.

4. Select Tools > Send to Workgroup.

The Send to Workgroup dialog box opens.
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5. To select a destination for the transferring assets, do one of the following:

t If your workgroup configuration contains presets, then you can select a preset from 
the Destination Preset menu to set the destination folder and workspace.

n Destination Presets are configured using the Interplay Transfer Preset view in the Avid 
Interplay Administrator. If no presets are configured, the Destination Preset menu does not 
display on the Send to Workgroup dialog box. For procedures on configuring a transfer 
preset, see “Configuring Transfer Presets” on page 44.

t If your workgroup configuration contains presets, but you do not want to use a 
preset, do the following:

a. From the Destination Preset menu, select None.

b. In the Destination area, select a folder where you want to transfer the metadata.

c. From the Workspace menu, select the workspace where you want to transfer 
the media file.

t If presets are not available, do the following:

a. In the Destination area, select a folder where you want to transfer the metadata.

b. From the Workspace menu, select the workspace where you want to transfer the 
media file. 

6. (Option) If you want to monitor the transfer, select the “Launch Transfer Status 
window.”

7. Click OK.

The transfer begins.

Transferring Avid Assets from Workgroup 4.5 to an Interplay 
Workgroup

You can transfer Avid assets from Workgroup 4.5 to an Avid Interplay workgroup. The 
MediaManager server in the Workgroup 4.5 environment must have TransferManager 
installed and configured.

To transfer Avid assets from Workgroup 4.5 to an Interplay workgroup:

1. From the Avid Interplay Administrator, click Interplay Transfer Status.

The Interplay Transfer Status dialog box opens.

2. Open the MediaManager in a browser.

3. Perform a search operation that returns the assets that you want to transfer.
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4. In the Results Frame of the MediaManager, click the asset, or Ctrl+click multiple assets 
that you want to transfer and drag them to the Interplay Transfer Status dialog box.

The Interplay Transfer begins a “pull” of the asset from the Workgroup 4.5 
TransferManager. The assets are added to the default folder, for example, Incoming 
Media folder.

Transferring Avid Assets in a Standalone 
Environment

In a standalone environment, Interplay Transfer can be used to transfer compositions and 
media from one Avid editing system to another Avid editing system. If you are transferring 
compositions or clips, you simply select the item from a bin and transfer it. If data is being 
sent to you from another Avid editing system, you simply choose to accept it.

If Interplay Transfer is properly installed and enabled on your Avid editing system, it starts 
automatically whenever you start the Avid editing application. To transfer assets between 
Avid editing systems, each Avid editing system must have the Interplay Transfer software 
installed. After you send the sequence, you can work on another project while the transfer is 
taking place. However, until the transfer operation is complete, certain operations will run 
more slowly. In the case of play back and capturing, you might experience interruptions.

For procedures on configuring your Avid editing system for transfers, see “Configuring the 
Avid Editing Application for Transfers” on page 57.

Transferring Avid Assets

To send clips or sequences to another Avid editing system:

1. Open the bin that contains the clips or sequences you want to send.

2. Select a clip or sequence, or Ctrl+click multiple clips or sequences.

3. Select Transfer > Send To Workgroup and then select the available workstation to which 
you want to send the assets.

The compositions, clips, and any available media are sent to the destination system.

For information on monitoring the transfer of the assets, see “Monitoring Transfers from 
Within the Avid Editing Application” on page 94.
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Transferring Avid Assets to a Playback Device

In a broadcast environment, you can transfer a finished sequence to a configured playback 
device. For information about configuring the playback device for transfers, see 
“Understanding the Avid Interplay Transfer Engine Configuration Settings” on page 38.

To send a finished sequence to a playback device:

1. Open the bin that contains the sequence you want to transfer.

2. Select the sequence. 

3. Select Transfer > Send To Playback, and select the available playback device to which 
you want to send the sequence.

The Send to Playback dialog box opens.

n If necessary, you can set the sequence to high priority by clicking the circle in the PWT (Play 
While Transferring) column next to the sequence.

c If you try to send a sequence or clip with the same tape ID as one the Interplay 
Transfer already has, you receive an error message. If you want to overwrite the tape 
ID name, select the Overwrite option. Overwrite the tape ID only if you are sure you 
want to overwrite the previous tape ID name.

4. Click OK.

The sequence is sent to the Interplay Transfer server, where it is sent to the selected 
playback device. You can now work on another project while the transfer is taking place.

For information on monitoring the transfer of assets, see “Monitoring Transfers from 
Within the Avid Editing Application” on page 94.
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Working with Rundowns

In a broadcast environment, you can enable the Interplay Transfer scheduling feature to 
allow interaction with the Newsroom Computer System (NRCS). You can select the assets to 
send to playback, and the schedule list from the NRCS determines the order in which the 
assets are played back.

To use the Interplay Transfer with rundowns:

1. On your Interplay Transfer server, click Start, and select All Programs > Avid > Avid 
Interplay Transfer Engine Configuration. 

The Interplay Transfer Engine Configuration window opens.

2. In the Playlist Information area, select “Use Newsroom rundowns to schedule transfers.”

3. Type the computer name of the Newsroom Server.

4. Type the user name and password.

5. If you know the name of the schedule file, type it in the Schedule File Name text box. 
The schedule file specifies which rundowns to use at which time. See “Creating a 
Rundown Schedule File” on page 83.

6. Click OK.

7. Restart the Interplay Transfer server. 

n Anytime the configuration information changes, you must restart the server.

8. On your Avid editing system, open the bin that contains the sequences you want to send.

9. Select the sequences. 
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10. Select Transfer > Send To Playback and select the available playback device to which 
you want to send the sequence.

The Send to Playback dialog box opens.

11. Click OK.

The sequences play back based upon the order in which they appear in the NRCS 
rundown list.

n In the Send to Playback dialog box, if you set one of the sequences to high priority by 
clicking the circle in the PWT column next to the sequence, that sequence has priority over 
the rundown list.

For information on monitoring the transfer of assets, see “Monitoring Transfers” on page 93.

Creating a Rundown Schedule File

A rundown schedule file tells the Interplay Transfer server which rundown to schedule at 
what time. The format is the time to start monitoring the rundown followed by the name of 
the rundown. For example:

# Rundown Schedule File 
# Number of elements 
9 
#Time (after) Rundown Name 
00:00:00 5a 
05:55:00 6a 
06:55:00 7a 
11:45:00 noon 
14:45:00 3pmcutin 
15:45:00 4pmcutin 
17:55:00 6p 
20:45:00 9pmcutin 
21:10:00 10p 
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Transferring Files from an Ingest Device

In a broadcast environment, you can transfer files from a configured ingest device to your 
Avid editing system bin.

To transfer files from the ingest device to your Avid editing system bin:

1. Ensure that the ingest device is properly connected. For more information, see the 
documentation supplied with your ingest device.

2. Open the ingest device’s application that lets you see the files located on the ingest 
device. 

A list of files located on the ingest device appears.

3. Open the bin on your Avid editing system where you want to capture the files.

You might have to minimize both the Avid editing application and the ingest device’s 
application so that you can view both at the same time on your desktop.

4. Click the media file you want to capture, and drag the file to your Avid editing system 
bin.

5. If you selected one item to transfer, a message appears asking if you want to initiate the 
transfer. 

Do one of the following:

t Click Now to transfer the assets. 

t Click Later, if you wait to transfer the asset at a later time. To transfer the asset at a 
later time, select Transfer > Retrieve.

The captured assets appear in the bin. To monitor the transfer, see “Monitoring 
Transfers” on page 93.
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6. If you selected multiple items to transfer, a message box opens, asking if you want to 
initiate the transfer. 

Do one of the following:

t Click Transfer; a message box appears for each clip. You must click OK in each 
message box to initiate the transfers.

t Click Transfer All; all the items selected are transferred.

t Click Defer; the assets are not transferred, and you see a message box to defer each 
asset. You must click OK in each message box to defer the transfers.

t Click Defer All; the assets are not transferred until you retrieve them. To transfer 
the assets at a later time, select Transfer > Retrieve.

The captured assets appear in the bin. To monitor the transfer, see “Monitoring 
Transfers” on page 93.

Transferring To and From Generic FTP Servers

To enable interoperability between Avid Unity family and third-party devices that use the 
MXF OP1a file format, Avid has developed an optional Avid Interplay Transfer Data 
Handling Module (DHM) plug-in that supports FTP integration to third-party MXF OP1a 
compliant devices. The Interplay Transfer MXF OP1a FTP DHM allows MXF OP1a files to 
be brought into an Avid Unity, Avid Unity ISIS, or an Avid editing environment from an 
FTP server. You can also export Avid media files in MXF OP1a format to an FTP server 
using this same MXF OP1a FTP DHM.

For procedures required to integrate a FTP server into a workgroup, see “Configuration for 
Capturing and Play Back of MXF DHM OPIa File Formats” on page 61.

The Avid FTP Media Browser application allows you to browse the contents of an FTP 
server to select the MXF OP1a files that you want to import into the Avid system. The MXF 
OP1a FTP DHM rewraps the imported files in Avid MXF-OP-Atom format.
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The MXF OP1a FTP DHM supports IMX 30, 40, 50, DV 25, and DV 50 in PAL and NTSC. 
The media format is not changed during the import process, just the metadata wrapper. 
Supported audio is 16-bit or 24-bit sampled at 48 kHz with up to 8 audio tracks. The MXF 
OP1a FTP DHM also supports the export of Avid IMX™ 30, 40, 50, DV 25, and DV 50 
media to an FTP server in MXF OP1a format.

n Avid editing applications do not play IMX files that are encoded on the Thunder system and 
then ingested into the Avid editing application. The media is always located in a Clips folder 
in each database.

The Interplay Transfer MXF OP1a FTP DHM was written to support MXF OP1a files that 
match the MXF OP1a reference standard. Because some vendors implement MXF OP1a 
support in a way that deviates from the reference standard, Avid cannot guarantee support 
for devices that do not comply with the reference standard. In addition, Play While Transfer, 
Overwrite, Frame-Chase Editing, and partial transfer capabilities are not supported with the 
MXF OP1a FTP DHM.

Interplay Transfer supports capture from and play back to File Transfer Protocol (FTP) 
servers that are compliant with FTP. You can transfer completed media sequences between 
Avid editing applications and generic FTP type servers. 

The FTP transfer of media is over standard TCP/IP Ethernet network. The FTP DHM 
supports connections to a FTP server using a valid DNS name or IP address. The FTP DHM 
can work with FTP servers on different subnets than the Interplay Transfer server.

n Microsoft .NET Framework 1.1 must be installed on the Interplay Transfer server and 
Interplay Transfer client systems when you are using FTP DHM. You can install .NET 
Framework during the Interplay Transfer installation.

During the transfer, the FTP DHM component supports the Run, Pause, Resume, Retry, and 
Cancel functions that are available from the Interplay Transfer server. Pause and Resume 
functions are constrained by the time-out setting on the FTP server. The components support 
multi-threaded operations that allow for simultaneous transfer operations to occur.

n If you cancel a transfer before it is complete, the part of the transfer that succeeded before 
the cancellation remains on the server.

For FTP transfer workflows, see the following sections:

• “Workflow: Ingesting Clips From an FTP Server” on page 87

• “Workflow: Play back to an FTP Server” on page 89
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Workflow: Ingesting Clips From an FTP Server

During an ingest, compressed frames are streamed from MXF OP1a files stored on a generic 
FTP server to the Avid editing system. Files ingested do not overwrite an already existing 
file. If a file already exists, a new file is created.

The audio or video format of the media is maintained during the capture process. Therefore, 
there is no visible or measurable distortion of either video or audio as a result of the transfer 
process. 

To ingest media from an FTP server:

1. Make sure the FTP server is properly connected and configured; see the documentation 
that came with your server.

2. Open a bin or create a new bin and position it in an unobstructed area.

3. From the Avid editing system, click the Start button, and then select All Programs > 
Avid > Utilities > Avid FTP Media Browser.

The Avid - FTP Media Browser opens.

Profile menuMedia list Connection Status box

Current Profile’s hostname and directory path

File Drag/Drop Support list
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4. Select a Profile from the Profile menu for the FTP directory where you want to access 
the media files. 

The status bar at the bottom of the Avid - FTP Media Browser window displays the 
hostname and directory path for the currently selected profile.

n For a procedure on how to create a new profile, see “Creating and Editing FTP Directory 
Profiles” on page 66.

5. Observe the connection status box next to the Profile menu.

This box indicates when the connection is complete. When the connection is complete, a 
list of files in the FTP directory displays in the Media List.

n If no activity occurs for a time-out period, the FTP connection is closed. You can click 
Update to reconnect to the FTP server.

6. (Option) Sort the files listed in the Media List by name, modification date, or size.

7. (Option) Click Update to refresh the list of files in the Media List.

8. Select the files in the Media List that you want to transfer to a bin.

9. Click Add to transfer the selected files to the File Drag/Drop Support list.

10. (Option) Click Remove to move a selected file from the File Drag/Drop Support list 
back to the Media List.

11. Select the files in the File Drag/Drop Support list and drag them to the Avid editing 
application bin to begin the transfer process.

A dialog box opens asking if you want to transfer the files now or defer the process to a 
later time.

12. Do one of the following:

t Click Now to begin the capture transfer.

t Click Later to defer the transfer to a later time.

Connection Status  

Color Indicates

Green Connected

Gray Not connected

Red Connection failed
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Workflow: Play back to an FTP Server

During a play back operation, media associated with a sequence from an Avid editing 
application is transferred to a FTP server. The media format in the Avid environment is 
MXF/AAF. The format of the data transferred to the FTP server is MXF OP1a format. 
However, the audio and video quality remains the same as the native Avid media. There is no 
visible or measurable distortion of either the video or audio as a result of the transfer 
process, and the transfer preserves the original media format (DV or IMX).

The name in the Tape ID field of the sequence is used as the name for the file created on the 
FTP server during a play back.

To play back a sequence to an FTP server:

1. Make sure the FTP server is properly connected and configured; see the documentation 
that came with your server.

2. Make sure the “Interplay Transfer Engine with Supplemental FTP Services” setting was 
selected as the installation type during the installation of the Interplay Transfer Engine 
application. See “Installing the Interplay Transfer Engine in a Workgroup Environment” 
on page 28.

3. Make sure the Interplay Transfer server is configured with the FTP server and FTP 
playback device. See “Configuring an FTP Server, FTP Playback, and FTP Ingest 
Devices” on page 61.

4. On the Avid editing system, select the sequence you want to play back.

5. Select Transfer > Send to Playback > Generic FTP playback device.

Generic FTP playback device is the device you added to the Interplay Transfer Engine 
Configuration tool. See “Configuring a Generic FTP Playback Device into a 
Workgroup” on page 64.

The play back transfer begins.

Capturing From FTP Deck Devices

TM-DHM is Avid’s API to integrate with third-party video server vendors. Avid has written 
its own integration to the DHM API for the Sony e-VTR and XDCAM™ deck devices. The 
integration supports MXF files by rewrapping them in AAF as they are brought into 
Avid Unity shared storage through the Interplay Transfer server. The integration supports 
IMX 30, 40, 50, and DVCAM in PAL and NTSC.

Unlike other DHM implementations, this does not enable users to “Send to Playback,” 
which would have allowed initiating requests from the editor that was writing to the decks. 
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The following sections give a general procedure for capturing clips from a FTP deck device 
and some 

• Capturing Clips From FTP Devices

• Workflow: Capturing Clips From an e-VTR Device

• Workflow: Capturing Clips from an XDCAM Device

Capturing Clips From FTP Devices

To capture clips from a FTP device:

1. From the Avid editing system, set the connection settings for the device. See “Setting 
the Ingest Device Connection” on page 71.

2. Open a bin or create a new bin and position it in an unobstructed area.

3. (Option) Open the Transfer Status window by selecting Transfer > Status Window.

4. From the Start button, select All Programs > Avid > Utilities > FTPClipList.

The FTPClipList dialog box opens. 

5. Click List Clips to view a list of the clips available from the device.

n If the device is busy, the list of available clips does not display.

6. Drag the clip you want to capture to a bin, to begin the capture process.

A dialog box opens asking if you want to transfer the files now or defer the process to a 
later time.
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7. Do one of the following:

t Click Now to begin the capture transfer.

t Click Later to defer the transfer to a later time.

Workflow: Capturing Clips From an e-VTR Device
1. Make sure the e-VTR device is properly connected and configured; see the 

documentation that came with your device. Set the following:

- Signal standard - NTSC or PAL

- Bit rate - IMX or DVCam

- Network settings - IP address, network mask, default Gateway

2. Make sure the “Interplay Transfer Engine with Supplemental FTP Services” setting was 
selected as the installation type during the installation of the Interplay Transfer Engine 
application. See “Installing the Interplay Transfer Engine in a Workgroup Environment” 
on page 28.

3. Make sure the Interplay Transfer server is configured with the e-VTR device:

a. On your Interplay Transfer server, click the Start button, and then select Programs > 
Avid > Avid Interplay Transfer Engine Configuration. 

The Interplay Transfer Engine Configuration window opens.

b. In the Ingest area, click Add.

c. In the Device dialog box, type the name associated with the e-VTR device on the 
network, for example evtr_wu, and then click OK.

d. Make sure the Workgroup Settings are set correctly. See the table in “Installing the 
Interplay Transfer Engine in a Workgroup Environment” on page 28.

e. Click Save.

4. Make sure the e-VTR device is configured in the e-VTR Manager application. See the 
documentation that came with your device. Set the following:

- Network device register - config name, host/IP address

5. Set up the device connection from the Avid editing system. For the setup procedure, see 
“Setting the Ingest Device Connection” on page 71.

6. Connect to the e-VTR device using the e-VTR Manager application. See the 
documentation that came with the device.

7. Start the capture. See “Capturing Clips From FTP Devices” on page 90.

When the transfer is complete, the clip appears in the bin.
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Workflow: Capturing Clips from an XDCAM Device
1. Make sure the XDCAM device is properly connected and configured; see the 

documentation that came with your device. Set the following:

- Signal standard - NTSC or PAL

- Bit rate - IMX or video

- Network settings - IP address, network mask, default Gateway

2. Make sure the “Interplay Transfer Engine with Supplemental FTP Services” setting was 
selected as the installation type during the installation of the Interplay Transfer Engine 
application. See “Installing the Interplay Transfer Engine in a Workgroup Environment” 
on page 28.

3. Make sure the Interplay Transfer server is configured with the XDCAM device:

a. On your Interplay Transfer server, click the Start button, and then select Programs > 
Avid > Avid Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

a. In the Ingest area, click Add.

b. In the Device dialog box, type the name associated with the XDCAM device on the 
network, for example xdcam_wu, and then click OK.

c. Make sure the Workgroup Settings are set correctly. See the table in “Installing the 
Interplay Transfer Engine in a Workgroup Environment” on page 28.

d. Click Save.

4. Make sure the XDCAM device is configured correctly. See the documentation that came 
with your device. Set the following:

- Set the FTP registration by adding a host name and IP Address for the XDCAM.

- Connect to the FTP device by typing a user name and password.

5. View the media on the XDCAM device. See the documentation that came with your 
device.

6. Set up the device connection from the Avid editing system. For the setup procedure, see 
“Setting the Ingest Device Connection” on page 71.

7. Start the capture. See “Capturing Clips From FTP Devices” on page 90.

When the transfer is complete, the clip appears in the bin.
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Monitoring Transfers

You can monitor the transfer of items from an Avid editing application, Avid Interplay 
Access, or the Avid Interplay Administrator software. If you monitor transfers from within 
the Avid editing application, you will see only the assets you transferred. If you open the 
Interplay Transfer Status window from the Avid Interplay Administrator, you can monitor 
all Interplay Transfer activity. If you have administrative privileges or you initiated the 
transfer, you can cancel, retry, pause, or resume transfers.

You can also monitor transfers from a standalone system using the Avid Interplay Media 
Services and Transfer Status tool. For more information about Media Services and Transfer 
Status tool, see “Configuring a Standalone System to Monitor Transfer Status” on page 53.

• Monitoring Transfers from Within the Avid Editing Application

- Sorting the Transfer Status Columns

- Clearing the Status Window

• Monitoring Transfers from Within the Avid Interplay Access

- Accessing the Interplay Transfer Status Window

- Understanding the Interplay Transfer Status Window

- Working with Filters in the Interplay Transfer Status Window
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Monitoring Transfers from Within the Avid Editing 
Application

After you transfer an asset from within the Avid editing application, you can monitor the 
transfer.

To monitor the asset transfer:

1. Display the Transfer Status window, by doing one of the following:

t For the Avid Instinct application, select File > Transfer > Show Status.

The TM Status tab displays the transfers.

t For other Avid editing applications, select Transfer > Status Window.

The Transfer Status window opens.

2. Right-click the status of a particular transfer to display the status options.

n A plus sign in the PWT column indicates the clip or sequence has been set to a high priority.

The following table lists the status options available during a transfer.

Status User Options

Transferring Pause or cancel the transfer.

Paused Resume or cancel the transfer.

Error (plus information indicating the error) Retry or clear the transfer.

Pending Cancel the transfer.

Completed or Canceled Clear the transfer.
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Sorting the Transfer Status Columns

You can sort the transfer status column into either ascending or descending alphabetical 
order. For example, you might want to view the status or locations of the transfers in 
alphabetical order. This makes it easy to view all the completed, paused, or canceled 
transfers together. 

To sort a transfer status column:

1. From the Transfer Status window or TM Status tab, right-click the column to display the 
sort options.

2. Select either Sort, Sort Reversed, or No Sort. Sort lists the information in alphabetical 
order.

Clearing the Status Window

When you are using the Status window from within the Avid editing application to view the 
status of any transfers, you should periodically clean up the Status window. The Status 
window is cleared of any leftover status messages when you exit the Avid editing application 
and then restart it. If you have not restarted the Avid editing application in a while, and your 
Avid editing system is appearing sluggish, clear the messages in the Status window.

To clear the Status window:

1. Do one of the following:

t In Avid Instinct, select File > Transfer > Show Status.

t In the Avid editing application, select Transfer > Status Window. 

The Transfer Status window opens.

2. Press Ctrl+A to select all the items in the Status window.

3. Press the Delete key.

All the items are removed from the Status window.
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Monitoring Transfers from Within the Avid 
Interplay Access

In Avid Interplay Access, you can monitor the transfer activity of all transfers within the 
workgroup. In the Interplay Transfer Status window, several filters are available to help you 
limit the list of transfers displayed in the status window. You can save filter preferences for 
easy access the next time you want to display the same limited list of transfers in the status 
window.

The following sections provide details about the Interplay Transfer Status window:

• Accessing the Interplay Transfer Status Window

• Understanding the Interplay Transfer Status Window

• Working with Filters in the Interplay Transfer Status Window

Accessing the Interplay Transfer Status Window

To access the Interplay Transfer Status window, do one of the following:

t From Avid Interplay Administrator:

a. Click the Start button, and select All Programs > Avid Interplay Access > Avid 
Interplay Administrator.

b. In the Site settings area, click Interplay Transfer Status.

t From Avid Interplay Access, select Tools > Interplay Transfer Status.

The status window opens and displays the transfer status of all jobs being transferred.
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Understanding the Interplay Transfer Status Window

The Interplay Transfer Status window shows all the current transfer activity. Filters are 
available to limit the number of transfers that display in the status window. For information 
about using the filters, see “Working with Filters in the Interplay Transfer Status Window” 
on page 99.

The Interplay Transfer Status window refreshes periodically to update the status 
information. You can change the default refresh intervals of the Interplay Transfer Status 
window. See “Setting the Refresh Time of the Interplay Transfer Status Window” on 
page 53.

The following table describes the information displayed in the Status area.

Filters

Status area

Saved 
Filters
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Interplay Transfer Status Area Details  

Status Area 
Column Description

Status Displays the status of the current transfers.

The color of the status row indicates the following:

• Gray with no icon = Transfer is pending or in the queue.

• Gray with Stop icon = Transfer has been canceled.

• Gray with Pause icon = Transfer has been paused.

• Yellow with no icon = Transfer is running.

• Red with X icon = Transfer has failed.

• Green with check mark icon = Transfer has completed successfully.

Name Shows the name of the media being transferred. 

Priority Lets you to set the priority of each transfer.

% Complete Indicates the percentage of the transfer that has completed.

TapeID The TapeID of a clip is the same TapeID used in the Avid editing application. This 
helps identify a particular piece of media.

Start Shows the time the transfer was started (not the time the transfer request was 
submitted to the Interplay Transfer server).

Destination Indicates the name of the workgroup receiving the transfer.

Type Indicates the transfer type: Workgroup pull, Workgroup push, Ingest, Playback.
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Working with Filters in the Interplay Transfer Status Window

The Interplay Transfer Status window provides filters to help limit the number of transfers 
displayed in the status window. You can save filter preferences for easy access the next time 
you want to display the same limited list of transfers in the status window. For descriptions 
of the various filter options, see “Description of Filter Options” on page 100.

To setup a transfer filter:

1. Open the Interplay Transfer Status window. See “Accessing the Interplay Transfer 
Status Window” on page 96.

2. From the Filters area, select the filter options you want to use. See “Description of Filter 
Options” on page 100.

The transfers that match your filter options selection display in the status area.

3. (Option) You can save the filter options to use another time. Do the following:

a. Click Save Current Filter.

The Enter filter name dialog box opens.

b. Type a name for the filter and click OK.

The new filter appears in the list of saved filters for use again.

To use a saved filter:

1. Click Saved filters to display a list of saved filters.

2. Select the filter you want to use.

3. Click Load to run the filter.
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To delete a saved filter:

1. Click Saved filters to display a list of saved filters.

2. Select the filter you want to delete.

3. Press Delete.

Description of Filter Options

The various filters let you limit the transfers displayed in the status area. The following table 
explains the filter options.

TransferManager Status Filters  

Filter Name Description

Status Select the current status of transfers you want to display: Cancelled, 
Completed, Error, Paused, Pending, Running. 

Source Select the system requesting the transfer.

Destination Select the system receiving the transfer.

Transfer Type Select the type of transfers you want to display: Workgroup pull, 
Workgroup push, Ingest, Playback.
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Interplay Transfer Select the Interplay Transfer Engine or Interplay Transfer enabled device 
that is handling the transfer. 

Explanation of Interplay Transfer filter options:

• The Avid Interplay Engine filter parameter lists all Avid Interplay 
Engines configured in the Interplay Transfer Settings view. For 
information about adding Avid Interplay Engines to the filter list, see 
“Adding Interplay Transfer Engines” on page 50.

• The Avid Interplay Engine filter provides an online/offline status 
indicator. If any Avid Interplay Engine in the TransferManager filter 
list is offline, then the filter changes to red. The text (Offline) displays 
next to the Avid Interplay Engines that are offline. 

• When you select an Avid Interplay Engine in the filter list, this only 
enables the status for that Interplay Transfer to display in the status 
area. Therefore, the filter selection has no effect on changing the 
Interplay Transfer’s online or offline state.

TransferManager Status Filters (Continued)  

Filter Name Description

The filter changes to red when 
any Interplay Transfer Engine 
is offline line.
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Chapter 6

Troubleshooting

This chapter describes how to detect problems you might encounter when using the 
Interplay Transfer as discussed in the following topics:

• Suggested Troubleshooting Guidelines

• Verifying Network Connectivity

• Increasing the Performance of Transfers

For additional troubleshooting information, see the Avid Unity documentation.

Suggested Troubleshooting Guidelines

The following guidelines can help you troubleshoot problems:

• Verify that Interplay Transfer is running on both the sending and the receiving systems. 
Interplay Transfer must be running on both systems.

• Verify that the network cables are securely connected between the computer and the site 
network.

• Verify that the network is operating and that your computer can detect the presence of 
the destination system. See “Verifying Network Connectivity” on page 104.

• If your computer has an optional network board, run the diagnostic programs provided 
with the board to verify that the board is functioning properly.

• If the system times out during transfers to your own computer or any other computer, 
ask the network administrator to verify that the Domain Name System (DNS) server 
specified in the TCP/IP properties of the Network settings in the Control areal is active 
and connected to the network.
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Verifying Network Connectivity

You can use the Windows operating system ping command to verify the network connection 
between your computer and another system on the network. 

n Before you use the ping command, make sure you know the system name or network address 
of the system you are pinging.

To check network connectivity:

1. Click the Start button, and then click Run. 

The Run dialog box opens.

2. Type the following command in the Open text box:

ping -t systemname

The variable systemname is the name of the system you are verifying.

The Windows Console window opens, showing the status of the pinging. 

3. Press Ctrl+C to stop running the ping command.

Increasing the Performance of Transfers

You can improve the performance of transfers by changing the file limit of media directories 
and setting the MegaByte multiple factor for read and write operations.

Changing the File Limit of Media Directories

When Interplay Transfer performs capture or heavy workgroup-to-workgroup transfers, a 
single directory can grow to more than 10,000 files. This can cause performance problems. 
By default, when Interplay Transfer starts, it checks the number of files in the Interplay 
Transfer managed directory. If the file count is greater than 95% of 10,000 files, it creates a 
new directory. If you want to lower these values, you must add new parameters to the 
TMserver.ini file.
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n File balancing is done only when the Interplay Transfer starts.

To change the file limit of media directories managed by Interplay Transfer:

1. Open the file C:\WINDOWS\TMserver.ini using WordPad.

2. In the [PMR Scan] section of the TMserver.ini file, add the following fields.

The following is a sample of media directories managed by Interplay Transfer:

\\unityFileSystem\workspaceName\Avid MediaFiles \MXF\TM_[tmserverHostname].

During startup only, the Interplay Transfer server checks each media directory for the 
number of files in the directory. If the media directory contains more files than specified by 
FileCountThreshold% of MaxFiles (for example, 95% of 10,000), the Interplay Transfer 
server creates a new directory using the same directory name and appends the name with an 
underscore and an incremental number.

For example, when the directory:

\\Unity1\WS1\Avid MediaFiles\MXF\TM_TransServer

becomes full, the next time the Interplay Transfer server TransServer is restarted, it creates a 
new directory named:

\\Unity1\WS1\Avid MediaFiles\MXF\TM_TransServer_1

and then _2, _3, and so on.

Fields Added to 
[PMR Scan] section Description

FileBalancing=1 FileBalancing – Turns off and on the feature for limiting the 
number of files allowed in a media directory. If FileBalancing is 
not present in the TMserver.ini file, the default is 1, indicating 
the feature is active.

MaxFiles=100 MaxFiles – Specifies the maximum number of files allowed in 
an Interplay Transfer media directory. If MaxFiles is not present 
in the TMserver.ini file, the default is 10,000 files.

FileCountThreshold=50 FileCountThreshold – Specifies, as a percentage, the file count 
threshold, over which the Interplay Transfer server creates a 
new media directory on its next startup. If FileCountThreshold 
is not present in the TMserver.ini file, the default is 95%.
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Additional File Count Logging

The Interplay Transfer server startup logging includes file count information. During startup, 
the Interplay Transfer server lists all the media directories on Avid Unity or Avid Unity ISIS. 
Each directory managed by the Interplay Transfer server is listed with three asterisks before 
it; each secondary directory has three hyphens before it. For all directories managed by 
Interplay Transfer, the number of files per directory is displayed.

In addition, a display of these PMR primary and secondary directories is included in the 
Interplay Transfer server’s dump command.

Increasing the Performance of Workgroup-to-Workgroup Transfers

When Interplay Transfer performs workgroup-to-workgroup transfers in an Avid Unity ISIS 
environment, you might notice slow transfer times. For better performance, modify the 
TMserver.ini file.

To increase the performance of workgroup-to-workgroup transfers:

1. Open the C:\WINDOWS\TMserver.ini file using WordPad.

2. Add the following parameter to the end of the TMserver.ini file, where MBFactor is the 
MegaByte multiple factor for read and write operations. The recommended value is 4.

[Buffer size]
MBFactor=4 
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attribute name Information in each record is recorded as a predetermined set of attributes. 
Each attribute describes a feature of the asset: for example, its name, creation 
date, or tape ID.

Assets Master clips, sequences, effects, and any other type of asset that reference 
digital media files. Assets also refer to the media files.

Avid Interplay 
Access

The Interplay Access lets you find, sort, and retrieve media.

Avid Assets Master clips, sequences, effects, and any other type of asset created by the 
Avid system that reference digital media files. Avid assets also refer to the 
media files.

Avid Interplay Avid Interplay system is a nonlinear workflow engine for managing assets, 
metadata, workflow, and security. 

Avid Unity ISIS 
media network

Avid Unity ISIS media network allows you to connect the latest in shared 
storage environments to your media network clients. The shared storage lets 
you set up a collaborative user environment where several editors can work 
on a project at the same time using the same media files and audio files.

Avid Unity 
MediaNetwork

Avid Unity MediaNetwork allows you to connect the shared storage 
environments to your MediaNetwork clients. The shared storage lets you set 
up a collaborative user environment where several editors can work on a 
project at the same time using the same media files and audio files.

browser A browser is an application program that provides a way to look at and 
interact with all the information on the World Wide Web.

data The information about media objects physically stored on drives (optionally 
mirrored for data security).

database services The software applications that drive the database functions.
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effect The manipulation of an audio or video signal. Types of film or video effects 
include special effects (F/X) like morphing; simple effects like dissolves, 
fades, superimpositions, and wipes; complex effects like keys and DVEs; 
motion effects like freeze frame and slow motion; and title and character 
generation. Effects usually have to be rendered because most systems cannot 
accommodate multiple video streams in real time.

See also rendering.

Fibre Channel Fibre Channel is a technology for transmitting data between computer 
devices at a data rate of up to 1 Gbps (one billion bits per second). Fibre 
Channel is especially suited for connecting computer servers to shared 
storage devices and for interconnecting storage controllers and drives.

Interplay Transfer The Interplay Transfer system manages the transfer of media to and from 
Interplay workgroups.

JPEG format A JPEG file is a graphic image created by choosing from a range of 
compression qualities (actually, from one of a suite of compression 
algorithms). When you create a JPEG file or convert an image from another 
format to a JPEG file, you are asked to specify the quality of image you want. 
Since the highest quality results in the largest file, you can make a trade-off 
between image quality and file size.

master clip The Avid asset that refers to the media files captured from tape or other 
sources.

MediaNetwork
server

The MediaNetwork server controls user access to the shared storage 
subsystem by logging in users through controlled user accounts with 
passwords. It also controls which workspaces a user can mount on the 
MediaNetwork client desktop and whether the user has read or write access 
to the files on the workspace. This allows a system administrator to control a 
user’s privileges and to manage the shared environment, preventing 
overwriting or damage to shared media files and audio files.

media objects Master clips, sequences, effects, and any other type of object that reference 
digital media.

metadata Data about data; for example, the clips associated with media files.

mirroring Duplication of the data on multiple drives in a redundant configuration. In a 
mirrored configuration, if one data drive fails, the mirrored drive is 
automatically used instead.
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motion effect An effect that speeds up or slows down the presentation of media in a track.

record For every asset, the database stores an associated record that contains specific 
information about the object.

rendering Merging effect layers to create one stream of digital video for play back in 
real time.

resync The resync process ensures that all the media on Avid Unity has been 
checked in to Avid Interplay Engine. When media files are copied into a 
shared storage environment manually, resync is necessary to make the 
compositional metadata (the clips associated with media files) appear in Avid 
Interplay Access.

sequence An edited composition that often includes audio and video clips and rendered 
effects connected by applied transitions.

SQL Server Structured Query Language (SQL) is a standard interactive and programming 
language for getting information from and updating a database. Although 
SQL is both an ANSI and an ISO standard, many database products support 
SQL with proprietary extensions to the standard language. Queries take the 
form of a command language that lets you select, insert, update, and find out 
the location of data.

subclip 1. An edited part of a clip. In a sequence, a subclip can be bound by any 
variation of clip beginnings, endings, and IN or OUT points.

2. A subclip created by marking IN and OUT points in a clip and by saving 
the frames between the marks. The subclip does not contain pointers to 
media files. The subclip references the master clip, which alone contains 
pointers to the media files.

TCP/IP network 
connection

Transmission Control Protocol/Internet Protocol (TCP/IP) is the basic 
communication language or protocol of the Internet. It can also be used as a 
communications protocol in the private networks called intranets and in 
extranets. When you are set up with direct access to the Internet, your 
computer is provided with a copy of the TCP/IP program just as every other 
computer that you might send messages to or get information from also has a 
copy of TCP/IP.

Transfer Engine The Transfer Engine manages the transfer of media to and from Avid 
Interplay workgroups.
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TransferManager The TransferManager system manages the transfer of media to and from 
Workgroup 4 workgroups.

Uniform Resource 
Locator (URL)

A Uniform Resource Locator (URL) is the address of a file (resource) 
accessible on the Internet.

workspaces Avid Interplay Engine clients mount media network workspaces on their 
workstations (requiring a user account to do so). Once mounted, workspaces 
behave like local media drives that can be accessed by others working on the 
same project. When the workspaces are properly configured, several users 
can access the same media and start using it immediately after it has been 
created.
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E
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F
Fibre Channel network 14
FTP Clip List

utility 71
FTP deck device

capture configuration 69
FTP Directory profiles

creating 66
FTP ingest devices

adding 70
configuration 61, 65
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FTP playback devices
configuration 61, 64

FTP servers
configuration 61, 62
Thunder server configuration 69

G
Guidelines
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Interplay Transfer client software 35
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settings 38
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Interplay Transfer server
installing 19, 20

Interplay Transfer settings
opening, Avid editing application 46

Interplay Transfer Status Window
set refresh 53

M
Media compatibility 76
MediaNetwork client software

installing 26
Monitor

AirSpeed transfers 51
refresh Interplay Transfer Status window 53
select cache engine 48
transfer setup 46
transfer status 33, 53
transfer status on standalone system 56

Monitoring transfers 93
MXF DHM OP1a file format
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P
ping command 104
Playback devices

catalog configuration 74
transferring files to 81
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detecting 104
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creating for transfers 44

Priority
in Status window 98

Problems
detecting 103

Profiles
creating FTP directory 66

Progress indicator
in Status window 98

R
Refresh

Interplay Transfer Status window 53
Remote workgroup connectivity

rules 15
typical configuration 16

Rundowns
working with 82

S
Schedules

working with 82
Setting up the Avid editing system 57
Settings list 57, 59
Site settings

Interplay Transfer 46
Software

Avid Unity ISIS client
installing 26

Interplay Adapter
installing 32

Interplay Media Services and Transfer Status tool 
32

Interplay Transfer Engine
configuration 37
installing 28

MediaNetwork client
installing 26

Sorting transfers 95
Standalone environment

configuration 57
using Interplay Transfer in 80

Standalone Interplay Transfer
supported configurations 14

Standalone system
monitoring transfers 33, 53, 56

Start
in Status window 98

Starting
Interplay Transfer server 25

Status window
described 97

Studio
monitoring transfers 51

T
TapeID

in Status window 98
Thunder server

adding 68
configuration check list 69
configure FTP server software 69
ImportWatcher folder setup 68

Timing out during transfers 103
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Transfer Presets
creating 44

Transfer settings
in an Avid editing application 57
in an Avid Unity environment 59

Transfer Status window 96
Transfer types 18
Transferring files

from a remote workgroup to an Avid system 77
from an ingest device 84
from one workgroup to another workgroup 77
from within an Avid application 76, 80
to a playback device 81

Transfers
method of accepting incoming 58
monitoring 93
monitoring from Interplay Transfer Status 

window 96
MXF DHM OP1a file format 61
setting up the Avid editing system for 57
sorting 95

Troubleshooting 103
Type column

in Status window 98

U
Utilities

Avid FTP Media Browser tool 66
FTPClipList 71

V
Verifying network connectivity 104

W
Workgroup environment

Interplay Transfer in 14
typical configuration with Interplay Transfer 14
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